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Before You Start

TETrans (acronym for Trace Element Transport) is a software
package that allows the user to simulate the vertical movement of
nonvolatile inorganic and organic chemicals through the vadose zone
under transient-state conditions. It is specifically designed to use a
minimum of input parameters and to use input parameters which
are easy to obtain relative to the input parameters of previous
transport models. The software package consists of two components:
the solute transport model and the user-friendly I/O (i.e.,
input/output) interface. The TETrans User's Guide centers its
discussion around these two components.

The User's Guide will provide a conceptual understanding of the
solute transport model component of the software so the model's
strengths and weaknesses are more apparent. A detailed description
of the I/O interface is necessary to provide the user-friendly tools
for creating the input file(s) and for getting the desired output. The
I/O interface is the shell of TETrans. It is through the I/O interface
that the necessary input information is entered for the transport
model component to create its simulations. Subsequently, the output
from the transport model component is displayed by the I/O
interface as text or graphics.

WHAT THIS PACKAGE CONTAINS

Please check to see that your TETrans software package includes the
following items:

0  TETrans application software - version 1.6
(TETrans)

0  TETrans MPW Fortran source code of the solute

transport model only - version 1.6 (TETranl_sub.f)

Sample parameter file (Sample Parameters)

User's Survey Questionaire

Optional upon request: TETrans journal publications

(2 articles from Journal of Environmental Quality)

< OO
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WHAT YOU NEED

¢  Minimum requirements: MacPlus with 1 MB
(i.e., megabyte) of RAM (i.e., random access
memory)

0  Preferable: Mac II or Mac SE/30 with 4-5 MB of
RAM

0  Macintosh System 6.0 or greater.

ABOUT THIS MANUAL

The User's Guide consists of 5 chapters:

0

Chapter 1: Installing TETrans discusses the
installation of the TETrans software.

Chapters 2: Introduction to TETrans describes the
solute transport model.

Chapters 3 & 4 discuss the I/O interface which allows for
the entry of parameter data and the selection of the type
of output desired. Chapter 3: Sample Simulation
provides a simulation using sample data provided in the
Sample Parameters file. Chapter 4: Using TETrans
goes through the use of the user-friendly Apple Macintosh
standard pull-down and pop-up menus, and dialogue boxes
for the entry and display of data.

Finally, Chapter 5: Troubleshooting TETrans contains
some useful hints in troubleshooting TETrans by providing
some "preventative medicine” suggestions and corrective
actions to error messages.
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CHAPTER 1: INSTALLING TETrans

INSTALLING TETrans

Before you do anything else, make a backup copy of the TETrans
disk. Refer to you Macintosh owner's guide if you need help. In
addition, make sure you have the Macintosh system software 6.0 or
greater installed on your hard disk (TETrans requires Macintosh
System 6.0 or greater).

To install TETrans create a new folder on your hard disk and name it
"TETrans". Copy all of the files from the TETrans disk into this new
folder. You are now ready to run.
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CHAPTER 2;: INTRODUCTION TO TETrans

This chapter provides a general description of the functional solute
transport model. It discusses the theory, preferential flow (i.e.,
hydraulic bypass) considerations, input parameter requirements,
applications, strengths and weaknesses. Recently published
literature which provides verification test data comparing measured
data and simulated results for the movement of chloride and boron
through a soil lysimeter column is presented in order to establish
credibility for the transport model.




ABOUT TETrans

Groundwater is a major source of our drinking, industrial and
agricultural water. Groundwater is becoming an even more
important natural resource as surface water supplies are depleted
and/or polluted.

The growing concern over health affects resulting from contaminated
drinking water has brought the degradation of our groundwater to
the forefront of public attention. Groundwater degradation is also an
agricultural concern because of the decrease in crop productivity
which can accompany the use of poor quality irrigation water. The
ability to model the migration of pollutants through the vadose zone
is an essential tool in combating the degradation of our groundwater.
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Over the past three decades numerous conceptual models for the
movement of solutes through the unsaturated zone have been
developed. Several reviews of these transport models have recently
appeared in the literature (Addiscott and Wagenet, 1985; Nielsen et
al., 1986; van Genuchten and Jury, 1987; Engesgaard and
Christensen, 1988; Feddes et al., 1988). Basically two groups of
transport models are recognized: deterministic and stochastic.
Within these two categories there are additional subcategories of
models. Functional models are a group of deterministic models
which utilize simplified treatments of solute and water flow while
making no claim to a fundamental description of the mechanisms
involved in the transport process. Functional models require less
input data and computer expertise for their application. As such,
functional models are management-oriented models. Several
functional models have been presented in the literature (Bressler,
1967; Tanji et al., 1972; Burns, 1975; Burns, 1976; Addiscott, 1977:
Rose et al.,, 1982; Bond and Smiles, 1988).

More than ever before, there is a need for simple, management-
oriented models for interpreting and simulating solute movement by
leaching. This need for functional transport models arises from two
limitations found in more theoretically rigorous mechanistic models
of transport. First, the soil data needed for sophisticated analytical
and numerical models are typically well beyond the capacity of most
real-world users, such as the EPA, Soil Conservation Service or
Agricultural Extension Service. Second, the spatial variability typical
of field soils limits the accuracy of application of exact transport
theory under field management situations. As pointed out by Bond
and Smiles (1988), "... the assumptions used to derive most flow
equations presented in the literature are not satisfied in field soils,
and analytical solutions of these equations are appropriate only to a
very restricted set of initial and boundary conditions." Stochastic
transport models do not provide a viable alternative for most real-
world applications since, again, the data upon which they are derived
are too labor and cost intensive to be practical.

In many well-drained soils, water movement responsible for solute
transport can be approximately and simply calculated using water-
balance accounting and a knowledge of field capacity. Using this
simplified approach, no quantitative knowledge of the soil's
hydraulic conductivity or of its moisture retention curves is
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required. Previous models have been developed on this premise by
Burns (1975), Rose et al. (1982), and Bond and Smiles (1988).
However, in each of these models it was assumed that no bypass flow
of water and solute through large pores had occurred. In aggregated
soil or soil high in clay, bypass flow paths through macropores and
cracks has a definite effect on the flow of solutes. In this case, flow
can deviate significantly from the near piston-type flow exhibited in
some well-drained soils. In addition, soil water may actually be
composed of two phases: an immobile water phase and a mobile
water phase (Turner, 1958; Coats and Smith, 1964; Deans, 1964). It
is only the mobile water phase which is miscibly displaced by
incoming precipitation or irrigation water. The immobile water
phase is bypassed.

TETrans (acronym for Trace Element Transport) was developed on
the premise of mass balance applied by Burns (1975) and on a
consideration of bypass flow. TETrans is a simplified mathematical
model of one-dimensional transport which simulates the vertical
movement of trace elements and nonvolatile organic and inorganic
chemicals through the vadose zone. The model is specifically
designed for real-world applications where little transport
information is known by or is available to the user. The model
utilizes a mass-balance approach to determine solution and adsorbed
(or exchangeable) solute concentration distributions. Several
modeling options are offered for simulating such transport-

influencing factors as plant water uptake, hydraulic bypass, exchange
and adsorption.

THEORY

TETrans is a capacity model which defines changes in amounts of
solute and water content rather than rates of change. As such, it is
driven by the amounts of rainfall, irrigation or evapotranspiration
(ET) and only considers time indirectly by using the time from one
irrigation or precipitation event to another. From a knowledge of
water inputs and losses, and of soil-solute chemical interactions,
TETrans predicts the average movement of reactive and nonreactive
solutes in the unsaturated zone of the soil. In TETrans, transport
through the soil profile is modeled as a series of events or processes
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for a finite collection of discrete depth intervals. These sequential
events or processes include: (1) infiltration and drainage to field
capacity, (2) instantaneous chemical equilibration for reactive
solutes, (3) water uptake by the plant root resulting from
transpiration and evaporative losses from the soil surface, and 4)
instantaneous chemical reequilibration. Each process is assumed to
occur in sequence within a given depth interval as opposed to reality
where transport is a collection of simultaneous processes.

Aside from conceptualizing transport as a sequence of processes, five
major theoretical assumptions are made in TETrans. First, drainage
occurs through the soil profile to a depth-variable field capacity.
Second, for a given depth interval the depletion of stored water by
evaporation and transpiration processes does not go below a field-
observable minimum water content which lies above the water
content associated with the wilting point of the crop. Third,
dispersion is assumed to be either negligible or part of the
phenomenon of bypass. Fourth, the chemical processes of
adsorption-desorption are nonhysteretic and instantaneous.  Fifth,
the soil profile can be divided into a finite series of discrete depth
intervals with each interval having homogeneous physical and
chemical characteristics.

On a microscopic scale, bypass can result when water moves through
pores where stagnant areas of immobile water exist. This immobile
soil water can exist as either a thin film around soil particles
resulting from adhesive and cohesive forces, or as stagnant water in
dead-end pores (Turner, 1958; Coats and Smith, 1964; Deans, 1964).
Adjacent to the immobile film of water around a soil particle lies a
mobile water phase. During an irrigation (or precipitation) event the
incoming water miscibly displaces the mobile water while the
immobile layer is bypassed. Bypass can also result from the
movement of water through large pores, thereby bypassing the
smaller pores. The net effect of bypass is that some resident soil
water containing a solute is not miscibly displaced by incoming
water. This subsequently affects the amount of solute within a soil-
depth increment. Previous functional transport models have not
dealt with the problem of bypass, which, in certain soils, can have a
very profound effect upon the movement and distribution of a
solute.
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Bypass flow in flux-based transport models (i.e., mechanistic models)
is distinguished by differences in pore-water velocity from one point
to the next. In contrast, bypass flow in capacity-based models, such
as a simple mass-balance approach, can be approximated by the
spatial variation in the quantity of the resident pore-water which is
not involved in piston-type displacement following an irrigation or
precipitation event. The quantity, or more specifically, the fraction
of the total resident soil solution which is not miscibly displaced by
incoming irrigation or precipitation water is subject to bypass. In
order to address the problem posed by bypass in the most simplistic
manner, a single term, the mobility coefficient (y), which accounts for
the effects of bypass due to the presence of immobile water and
preferential flow through large pores and cracks is used in TETrans.
(NOTE: the mobility coefficient is the fractional representation of the
percent water bypass. Water bypass % is actually the prompt used
by the TETrans I/O interface - see the "Input Parameters" section of
this chapter and the "Hydraulics" subsection of Chapter 4: Using
TETrans for further details). The mobility coefficient is defined as
the fraction of the resident soil water which is subject to
displacement; therefore, 1-Yy represents the fraction of soil water
which is bypassed.

Model Description

The following model steps outline the sequence of events for the
transport process within a defined depth interval, z1 to zo (see
Appendix A for any undefined terms):

A. Infiltration and drainage

1. Before an irrigration (Bl) or precipitation, the total

amount of solute, Tpgy, in a layer of soil, z1 to z», is
represented as,

TBI=Tsw + Tad = Vi [ 0BICBI + ppCad ] = VBICBI + VippCad  [1]

where: Viis a unit volume of soil within the depth
interval z4 to zp (m3); Tgyis the total amount of solute
in Viimmediately before an irrigation (kg); Tsw is the
total amount of solute in the soil water of Vi (kg); Taq is
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the total amount of adsorbed solute in Vi (kg); 0p is
the volumetric water content immediately before an
irrigation (cm3/cm3); Cpg; is the concentration of solute
in the soil water immediately before an irrigation
(kg/m3); pp is the soil bulk density (kg/m3); Cgaq is the
adsorbed solute concentration (kg/m3); and Vg is the
volume of soil water in Viimmediately before an
irrigation (m3).

. After an irrigation and drainage to field capacity (Al),

the total amount of solute, Taj, is the result of what
was present before the irrigation plus what entered
minus what went out,

Tai=Tgi + Tin - Tout = Ti + VinCin - VoutCout [2]
a. where if 0 <y< 1 and

(1.) if Vip>Vie-(1.0-7v) Vg, then

Vout = Vin - V¢ + VB [3]

Cout ={Y VBICaI - VicCin + VinCin + (1.0 -¥) VBICin} / Vout [4]

Var= Vi (5]
Cal ={(1.0-v) VBICgi + (Vic- (1.0-Y) VBI) Cin} / Vi [6]

(2.) elseif Vic - VeI < Vin < Vic- (1.0 - ¥) Vgi, then

Vout = Vin - Vic + VB [7]
Cout = Cpi (8]
Vai= Vi [9]
Cal ={ (Vic - Vin) CaI + VinCin } / Vic [10]

(3.) elseif Vijn < Vic - VB|, then
Vout =0 [11]

Cout =0 [‘1 2]
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Vai=Vai + Vin [13]
Cal = (VBICgI + VinCin) / (VBI + Vin) [14]

b. otherwise if Yy = 0 and

(1.) if Vin > Vic - Vg, then Egs. [3], [4], [5] and [6]
are applied.

(2.) elseif Vin < Vic - Vg, then Egs. [11], [12], [13]
and [14] are applied.

where: Ta| represents the total amount of solute in a
volume, Vi, of soil after an irrigation (kg); Tin is the
total amount of solute entering Vi (kg); Tout is the total
amount of solute leaving Vi (kg); Vijn is the volume of
water entering Vi(m3); Ca| is the concentration of
solute in the soil water after an irrigation (kg/m3); Cin
is the solute concentration of the entering water
(kg/m3); Voyt is the volume of water leaving Vi (m3);
Cout is the solute concentration of the exiting water
(kg/m3); v is the mobility coefficient, or more
specifically, the fraction of Vg; which is subject to
piston-flow (where, 0 £ Y< 1, Y= O represents total
bypass, Y =1 represents complete piston-type flow);
1.0 - v is the fraction of Vg; which is subject to bypass;
VAl is the volume of soil water in Vi after an irrigation

(m3); and Vi¢ is volume of water in Vyat field capacity
(m3).

B. Chemical equilibration

Chemical equilibration involves the partitioning of a
reactive solute into the solution and adsorbed or exchange
phases. Based on the conservation of mass, the total amount
of a reactive solute in a layer of soil, z1 to zp, of thickness z
(total volume Vi) after an irrigation is equal to the amount of
reactive solute present before the irrigation, plus the total
solute entering the layer minus the total solute leaving the
layer. This is represented in simple mathematical form as
Eq. [2]. After an irrigation the volume of water in Vi equals
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Cal=

either field capacity, Va| = Vi, or Va] = V| + Vin. Assuming
instantaneous adsorption-desorption and assuming the
reactive solute obeys the Langmuir adsorption isotherm
model, Ta| is partitioned into the adsorbed and the solution
phases according to Eq. [15],

Tar= VAl Cal+ Vipp [kbCal/ (1 + kKCal) ] [15]

where: Ca| is the concentration of the solute in the soil
water after an irrigation (kg/m3), pp is the bulk density
(kg/m3), k is the Langmuir affinity coefficient (m3/kg) and b
is the adsorption maximum (mg/kg). Using Egs. [2] and [15]
and solving for Cp), Eq. [16] is obtained,

L
-(Var+Vippkb - Tark) £ 1/(VA|+Vthkb-TA[k)2+4VA|kTA|

[16]
2Vark

where the positive solution is the one needed. The total

amount of solute in the adsorbed phase is represented by
Eq. [17],

Tad = Vi Cad=Vippo [kbCal/ (1 + KCal) ] [17]
and therefore, the adsorbed solute concentration, Cgaqg, is,
Cad = Po [ KbCal/ (1 +kCal)] [18]

Equations [16] and [18] determine the solution and adsorbed
phase solute concentrations following an irrigation by using
the value of Taj from the mass-balance equation (Eq. [2])

and the appropriate value for Vaj, either field capacity, Va| =
Vic, or VAl = V| + Vin. The same logic can be followed for

other chemical models including the Freundlich or linear
adsorption model and the Mezuman-Keren boron adsorption
model.

Plant water uptake
The total amount of evapotranspiration between irrigation

events and the plant root distribution of a crop are needed
as input for TETrans. The plant water uptake model simulates
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the net loss of water from each depth increment within the
root zone of a maturing plant. Root growth is assumed to
occur linearly from the date of planting to the date of
maturity. If the plant is harvested and the root system is
terminated, all subsequent loss of water from the root zone
occurs by a simulation of evaporative loss from the soil
surface. TETrans does not account for the upward
movement of solute resulting from the processes of
evaporation or transpiration. Evapotranspiration is only
viewed as a sink for water loss which results in the
concentration of the solute within the root zone. It is not
viewed as creating a potential gradient which results in the
net movement of the solute.

In TETrans the distribution of the removal of water by

the plant root is fitted with the option of two models: linear
or exponential distribution. The linear root water uptake
model is that of Perrochet (1987) which is a synthesis of
previous models and work presented by Molz and Remson
(1970), Feddes et al. (1978), Hoagland et al. (1981), Ritchie
(1984), Ritchie et al. (1984) and Prasad (1988). On a
capacity basis, the volumetric root extraction function, S, is
expressed by,

S(y.2) =r(y) g(2) Tp [19]

where, Y is the soil-water suction head (m), z is the soil
depth (m), r(y) is the reducing factor, g(z) is the root
distribution function and Tp is the potential volumetric
transpiration (m3). Perrochet (1987) expresses the linear
root distribution function by,

g(z)={o (2z-L)+L}/L2 [20]

where, 01 is the linear plant root disrtibution coefficient (-1 <
01 <1),z< L and L is the plant root depth (m). The root
distribution function must be normalized so that its integral
over L is unity. It is assumed for the model that moisture
conditions are optimal; consequently, the reducing factor,
r(y), is equal to 1. Since the actual volumetric transpiration,
Ta, is the integral of the volumetric extraction function from
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the soil surface (z = 0) to the depth of root penetration (z=L),
then the relative water uptake for a linear root distribution,
Ui(z), over the soil depth interval z1 to z2 (where, 0 < 21 < Z2 <
L) becomes,

Ui(z) = [0t /L2 ] (222 - z42) - [ (014 /L) - (1/L)] (22 - Z4) . [21]

Following the same logic, the relative water uptake for an
exponential root distribution, Ug(z), over the soil depth
interval z4 to zo becomes,

Ue(z) = (€321 - e822) /(1 - g-aL) [22]

where, a = 02 / L, and o2 is the exponential plant root
distribution coefficient. Therefore, the water loss within the
z1 to z2 depth interval is equal to the actual volumetric
transpiration multiplied by the relative water uptake. Vaj
is adjusted to Vei which represents the volume of soil water
in V¢ following the removal of water by root uptake to meet
transpiration needs. So, the water withdrawn by plant roots
for any given depth increment, z4 to zp, is removed in a
manner which corresponds to the relative plant root water
uptake expressed by either Eq. [17] or [18] which are a
reflection of the plant root distribution. Within any given
depth increment, the residing soil water cannot be
withdrawn below a minimum volume of water, Vmin, by the
plant root. Vmin is an empirical value which lies above the
water content at the wilting point and represents the lowest
volume of water which is observed to occur within Vi for

all ET events.

Concomitant with the removal of water by the roots is

the concentration of the solute. During the extraction of soil
water, roots behave similar to a semipermeable membrane.
Solutes remain behind as the water is extracted. Therefore,
evapotranspiration results in the concentration of solutes
within the root zone.

Chemical reequilibration

Following the removal of water by the roots the
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volume of water in Vi just before the next irrigation
becomes,

Vel = Vai- Vet [23]

where Vet is the volume of water in Viremoved by
evapotranspiration (m3). Concomitantly, the solute is
concentrated by the factor Va| / Vet and another chemical
equilibration occurs. Once again, Eqs. [16] and [18] are used
to determine the solution and adsorbed phase solute
concentrations except Vpjis used in place of V).

Bypass Considerations

In the current version of TETrans, the mobility coefficient (or
fraction of water involved in bypass flow) can have values which are
constant over time and depth, or constant over time and variable
with depth. In the future an additional option of the mobility
coefficient will be variable over time and with depth. The easiest
way of determining mobility coefficient values for the first two cases
(i.e., constant over time and depth, or constant over time and
variable with depth) is simply by trial-and-error. Mobility
coefficient value(s) are simply selected which result in the best
simulation of measured chloride concentrations in the soil solution.

Corwin et al. (1990a) have already shown how mobility coefficient
values which vary both temporally and spatially can be determined.
(To obtain the software for determining spatially- and temporally-
variable bypass coefficient values contact D. L. Corwin). The
determination of temporally- and spatially-variable values for the
mobility coefficient is based upon the deviation of measured soil
solution chloride concentrations from calculated concentrations
assuming complete piston-type displacement of solute. In TETrans
this deviation is assumed to be attributed in large part to bypass
resulting from preferential movement through macropores and from
the movement of a mobile water phase, thereby bypassing small
dead-end pores and a stagnant immobile phase of water. Though
dispersion and anion exclusion would also account for the deviation
of chloride transport from strict piston flow, these effects are
assumed to be neglible. If dispersion is a significant factor then its
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effects are assumed to be inclusive within the bypass phenomenon,
and compensated for in the mobility coefficient. To calculate the
mobility coefficient, vy, for each irrigation and for each depth

increment, Eqs. [2] and [4] are used. Eq. [2] can be rearranged to give
Eq. [24],

Cout=( TBI + VinCin - Tai ) / Vout [24]
and Eq. [4] can be rearranged to give Eq. [25],

Y= (VoutCout - VoutCin ) / ( VBICBI - VBICin) - [25]

Since Ta| can be calculated from the measurement of the chloride
concentration of the soil solution at field capacity (for a nonreactive

solute, Ta| = VicCsc), then Y can be determined by substituting Eq. [24]
into Eq. [25],

Y = ( VinCin + TBI - VicCtc - VoutCin ) / ( VBICBI - VBICin ) [26]

which is the same as multiplying Egs. [5] and [6] and solving for 7.
Equation [26] holds for the situation where Vjn > Vic - (1.0 - Y) Vg for 0 <
Y< 1. However, since Yis precisely the term that is being determined,
then Eq. [26] can only realistically be used when Vin > Vie. If it is
found that the total chloride, Tp|, measured for a depth increment is
equal to Eq. [9] multiplied by Eq. [10] (i.e., Tal = (Vic - Vin) CaI +VinCin ),
then it is known that the condition Vi¢ - Vgj < Vin < Vic - ( 1.0 - Y) Vg for O
<Y =< 11s the case; consequently, it is assumed that,

Y= (Vin-Vic + Vi) / Vg [27]

since it is impossible to determine 7y explicitly and this represents the
closest logical approximation. If the total measured chloride is equal
to Eq. [13] multiplied by Eq. [14] (i.e., Tai= VBICBI + VinCin ), then it is
known that the condition Vin < Vic - VB| exists: consequently, ¥ = 0 is
assumed. If Taj = VgiCpg| + ( Vic - VB )Cin (i.e., Taj equals Eq. [5] multiplied
by Eq. [6] for ¥ = 0) when Vin > Vi¢ - Vpy, then Y = 0. The only condition
for which ¥y has not been determined is when Vic - ( 1.0 - Y) VBi< Vin<
Vic for 0 <y < 1. If all other conditions are not met, then this condition
is assumed to be the case and Eq. [26] is invoked. Anomalous
situations could arise where 7 is calculated by Eq. [26] to be outside its
defined range. By definition 0 <Y< 1, so if yis calculated to be less
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than O, then 7y is set equal to 0. Similarly, if Y is calculated to be
greater than 1, then Yis set equal to 1. The possible reasons for y
extending beyond the range of 0 to 1 would be soil solution sampling
errors and errors in the measurement of soil solution chloride levels.

INPUT PARAMETERS

The input parameters needed by TETrans for each soil layer include:
soil layer thickness; water bypass percentage; initial solute
concentration in the soil water; initial water content of the soil;
adsorption coefficients; dates and amount of irrigation water applied;
total evapotranspiration between irrigations; bulk density; water
content at field capacity; minimum water content (or water content
just above the wilting point); solute concentration of each irrigation
water applied; and date of planting, days to maturity, date of
harvest, maximum depth of root penetration and plant root
distribution for each crop.

Though seemingly formidable in its input requirements, TETrans is
far less parameter intensive than other transient-state models of
solute transport, especially previous analytical and numerical
deterministic models. In addition, the input parameters are more
readily obtained since TETrans is a capacity-based model;
consequently, complex parameters for rate-based models such as
hydraulic conductivity - matric potential relations, dispersion - pore
water velocity relations and water content - matric potential
relations are not needed. Furthermore, capacity parameters are
known to be less spatially variable than rate parameters.

A discussion of some of the less intuitive input parameters is
provided for the user. The appropriate units of measurement for

each input parameter are provided for the user within each input
dialog box.

Percent Water Bypass

The most difficult parameter to determine is the fraction (or
percentage) of water which is involved in bypass flow, referred to in
the "Theory" section of this chapter as the mobility coefficient. A
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detailed description of how the mobility coefficient can be
established is given in the "Bypass Considerations" section. A
mobility coefficient of 0.50 (or 50% water bypass) was found by
Corwin et al. (1990a) for a loam soil.

Immobile Water Fraction

The immobile water fraction is another means of handling bypass
flow in TETrans. As pointed out in the "Theory" section of this
chapter, there are believed to be two phases of soil water during
water flow: a mobile and an immobile water phase. The immobile
water phase is bypassed by the mobile phase as water moves
through the soil profile. Several mechanistic models have been
developed around the existence of mobile-immobile water phases
and they will not be discussed here. For overviews of this modeling
approach the user is referred to brief, but insightful review articles
by Addiscott and Wagenet (1985), Nielsen et al. (1986) and van
Genuchten and Jury (1987). Though hard to find, some immobile
water fractions for different soil textures have been calculated and
appear in the scientific literature. Stony soil and sandy soil have
been found to have immobile water fractions of 0.15 and 0.33,
respectively.

In TETrans, a value must only be entered either for percent water
bypass or for the immobile water fraction, but not for both. Though
the user is never aware of it, there are actually two solute transport
models in TETrans: a hydraulic bypass transport model and a mobile-
immobile transport model. The solute transport model that is chosen
depends upon which hydraulic parameter, either percent water
bypass or immobile water fraction, receives a value from the user.
The mobile-immobile transport model is not only capable of handling
the physical phenomenon of hydraulic bypass, but it also models
diffusion-controlled physical nonequilibrium. The mobile-immobile
model assumes that the sorption rate is controlled by the rate at
which ions diffuse from relatively mobile (flowing) liquid regions to
reaction sites in equilibrium with immobile (nonflowing or dead-end)
water. Diffusion into and out of the immobile water areas is modeled
as a first-order exchange process.

In the current version of TETrans (version 1.4), the immobile water
fraction prompt appears grayed-out indicating that it is inactive.
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This is because the mobile-immobile transport model is not present
in version 1.4. At present the mobile-immobile transport model is
involved in a verification study comparing various transport models.
Once the results of this study are published, the mobile-immobile
transport model will appear in TETrans, version 2.0, along with
several other modifications. All users will receive the updated
TETrans version after the publication.

Evapotranspiration Amount

The evapotranspiration (ET) amount may also be difficult to
determine. TETrans specifically requests the amount of ET between
irrigation or precipitation events. A precipitation/irrigation event is
considered to be each day that irrigation water is applied or
precipitation occurs. Therefore, the ET is calculated to be the total

evapotranspiration from one irrigation/precipitation event to the
next event.

A gross estimate of evapotranspiration can be made from
consumptive water use data for a crop. Consumptive water use data
is generally available for various locations from either irrigation
management district offices, the state department of agriculture, the
local agricultural extension office or the local soil and water
conservation agency. If the crop consumptive water use is known
then a simple sinusoidal wave can be applied to estimate daily
evapotranspiration requirements. From this information, the total
evapotranspiration between irrigations (or precipitation events) can
be easily estimated.

Adsorption Coefficients

Adsorption coefficients are probable the next most difficult
parameter to determine or locate in the literature. A good general
reference for adsorption coefficient data and methods of estimating
adsorption coefficients is W. J. Lyman's chapter titled "Adsorption
Coefficient for Soils and Sediments" in Lyman, Reehl and Rosenblatt's
Handbook of Chemical Property Estimation Methods. (Note:
Estimated adsorption coefficients should only be used when there is
no other source of information because estimation methods of
adsorption coefficients are generally very inaccurate). With regards
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to the Keren boron adsorption coefficients, the user is referred to the
publications by Keren and Mezuman (1981), Mezuman and Keren

(1981), and Keren et al. (1981) which are listed in the reference
appendix.

Plant Parameters

The plant parameters including maximum root penetration depth
and root water uptake distribution for a crop or vegetative cover are
usually available from the local agricultual extension personnel. As a
rule-of-thumb, most plants are believed to have water uptake
distributions of 40-30-20-10. In other words, 40% of the total
transpired water is taken up from the top quarter of the root zone,
30% from the second quarter of the root zone, 20% from the third
quarter and 10% from the bottom quarter. Unfortunately, maximum
plant root depth can vary considerably from crop to crop and
sometimes even from one location to the next. Check with local
extension experts to get the best possible estimate.

Field Capacity

A parameter which may be unknown outside of the confines of the
soil scieince field is that of field capacity. Field capacity represents
the water content of a soil or soil layer after free drainage has
stopped. This is generally considered to be the water content of the
soil 2-3 days (sometimes longer depending on the soil texture) after
an irrigation event. Field capacity can range from 0.08 cm3/cm3 for
a sandy soil to 0.35 cm3/cm3 for a clay soil.

Minimum Water Content

The minimum water content is considered to be the lowest water
content reached within a soil layer as a result of the extraction of
water by plant roots. This water content is slightly above the water
content at the wilting point of the plant. A range of minimum water

contents would be 0.05 cm3/cm3 for sandy soil to 0.16 cm3/cm3 for a
clay soil.

Soil pH

Soil pH is a parameter that needs no real discussion, except with
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regards to its use by TETrans. In TETrans, pH is only needed when
using the Keren boron adsorption model. For this chemical model
selection, pH information is needed as an initial condition and after
each irrigation or precipitation event. Make sure that pHs are
entered for both situations. The soil pH should be measured at field
capacity just after an irrigation or a precipitation event. (See the
Soil pH command of the Parameters menu in Chapter 4: Using
TETrans for additional information).

The extreme range of pH for most mineral soils is 3.5 to 10.0.
However, the common range in pH for humid region mineral soils is 5
to 7, while arid region mineral soils commonly range from 7 to 9.

APPLICATIONS

TETrans was developed to meet two application needs. The first was
for assessing the movement of nonvolatile solutes under transient-
state field conditions. This would meet the needs of agricultural,
industrial and engineering applications. The second was as an
educational tool for studying the interrelationship of the
physicochemical processes involved in the movement of a
nonreactive or reactive solute through the vadose zone.

The need for a practical, management-oriented model for simulating
solute movement by leaching is based upon two limitations of more
theoretically rigorous models of transport. First, the soil data needed
for sophisticated analytical and numerical models is typically well
beyond the capacity of real-world users. Second, the spatial
variability typical of field soils limits the accuracy of application of
exact transport theory. Stochastic transport models do not provide a
viable alternative for most real-world applications since again the
data upon which they are derived is too labor and cost intensive to
be practical.

As an educational tool, TETrans' user-friendly I/O interface reduces
the complexities of input and output found in most transport models
to interactive menu screens and dialog boxes. The user's time is

spent more in the analysis of output than in learning how to operate
the software. As a functional model, TETrans incorporates simplified
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treatments of solute and water flow with no claim to fundamentality;
consequently, the effects of dispersion and preferential flow are
lumped into a single term. In addition, no regard is given to the
kinetics or hysteresis of adsorption-desorption reactions.
Nonetheless, the basic interrelationships between water movement,
evapotranspiration, and the equilibrium-chemistry processes of
adsorption and exchange can be studied.
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VERIFICATION TEST DATA

Verification test data for TETrans is documented in two Journal of

Environmental Quality publications by Corwin et al. (1990a and
1990Db).

2-19



STRENGTHS & LIMITATIONS

TETrans' strengths include:

O specifically designed for real-world transport applications

0 designed to use input parameters which are readily available

0 uses capacity input parameters which are less spatially
variable than rate parameters

0 has the computational speed of an analytical solution

0 has the versatility of a numerical approach

0 designed with a user-friendly I/O interface

A more detailed discussion of each strength is provided:

TETrans is a solute transport software package which is specifically
designed for real-world transport applications. Because of cost
constraints, real-world problems rarely permit the acquisition of
difficult-to-measure parameters commonly needed for most
transport models (i.e., mechanistic and stochastic models). For this
reason, TETrans is designed for situations where there is a limited
knowledge of sophisticated transport information. There is no need
for dispersion - pore velocity relationships, water content - matric
potential relationships and hydraulic conductivity - matric potential
relationships.

Functional models, such as TETrans, make no claim to fundamentally
describing the individual processes involved in transport. Rather,
the mechanisms are treated in a simplified manner. As a functional
model, TETrans requires capacity parameters which are known to be
less spatially variable than rate parameters. In addition, capacity
parameters are generally more readily available because they are
easier to measure than rate parameters. Furthermore, because
TETrans uses a mass-balance approach, it offers the speed of an
anlytical solution, yet it has the versatility of a numerical approach,
without a significant sacrifice in accuracy.

To add to TETrans' utililty, a user-friendly interface which uses Apple
Macintosh standard pulldown menus and dialog boxes has been
incorporated. The I/O interface enables the user to spend less time
learning the operation of the software and more time analyzing data.
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In contrast, the weaknesses of TETrans include:

does not account for vapor phase flow

does not account for lateral or upward water flow

does not fundamentally describe dispersion or diffusion
does not have the ability to account for spatially varying soil
properties

requires a precise knowledge of evapotranspiration

outputs concentration distributions which are average
concentration distributions

(e le e R el

< O

A discussion of each weakness is presented:

First and foremost, TETrans is designed to serve as a tool for use on
real-world problems. To adhere to this philosophy of design, certain
limitations on TETrans' complexity had to be made. Because the
intended purpose of TETrans is to simulate the one-dimensional
vertical transport of nonvolatile solutes, no consideration is given to
vapor phase flow or lateral water flow. In the current version, the
upward movement of water also is not taken into account.

To maintain its simplicity and practicality, TETrans is designed to be
a management-oriented model, so its use as a research tool is limited
because it is not mechanistically rigorous. In TETrans, there is no
claim to a fundamentally rigorous description of the mechanisms
involved in solute transport.

Even though TETrans uses capacity-type input parameters which are
less spatially variable than rate parameters, it is still a deterministic
model. As a deterministic model, a uniquely-definable outcome is
presumed; therefore, TETrans does not account for spatially variable
soil properties. However, stochastic models which do account for
spatial variability are prohibitively expensive due to the intensive
labor requirements necessary to establish the probability density
functions for each property influencing the transport process.

Even though TETrans is designed for simplicity of use, some of the
input parameters may still be difficult to obtain. Because TETrans
uses a mass-balance approach, a precise knowledge of the amount of
evapotransporation is essential, but evapotranspiration is often
difficult to accurately measure. However, this is a weakness of all
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transport models. Evapotranspiration is a crucial sink term in any
modeling approach.

The solute concentration determined by TETrans is an average
concentration for a depth increment rather than the single-valued
concentration associated with a specific depth of mechanistic-
deterministic models. For practical applications, average
concentrations are usually an adequate first approximation to the
description of solute movement.
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CHAPTER 3: SAMPLE SIMULATION

This chapter provides the user with a sample simulation. The sample
simulation will walk you through the basic operation of TETrans' user-
friendly I/O interface. Upon finishing the sample, more detailed

information on any of TETrans' functions can be found in Chapter 4:
Using TETrans.




Starting the Sample Simulation

The first step, if you haven't done so already, is to copy TETrans to your
hard disk, if you have one, or to another floppy. Never work with the
original TETrans disk. See Chapter 1: Installing TETrans.

To begin the sample simulation, locate the TETrans folder (on your hard
disk or floppy) and double-click on the folder to open it. Then start
TETrans by double-clicking on the TETrans application icon.

0 Choose Open Parameters... from the File menu. A dialog
box appears:

S TETrans
[ sample Parameters = Mr. MegaB...

[ fjeqt

[ Drive

S

) -

( Open

| S

gy ( cancel

0 Select the sample data file of input parameters titled "Sample
Parameters” by clicking on it once with the mouse. Then click on
the "Open" button. This will dismiss the dialog box and load in the
TETrans model parameters from the file.

0 To view any of the model parameters, select any of the items from
the Parameters menu. For example, to view the boundary
conditions, choose Boundary Condition... from the Parameters
menu. A spreadsheet window will appear:
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EO Boundary Condition
7 | Time (days) | Amount (cm) | Conc (mg/1) ET (em) {3
1 | 8.500 1.000 5.000
2 7.000 9.000! 1.000: 5.000
= e e e s —
4 21.000} $.000 1.000: 5.000
o s = o T =
6 35.000 8500 1.000 5.000
= e e T o5
8 49.000 8.5001 1.000} 5.000
9 56.000 9.000' ‘os00i 5.000 [0
10 63.000 9500 0.500 5.000 |

This spreadsheet contains information about the amounts of water
and solute entering or leaving the surface of the soil. The Time
column has the times of all of the irrigation or precipitation
events. The Amount column has the amounts of irrigation water
applied or precipitation that fell for each event. The Conc column
has the irrigation water concentrations for the solute being
modeled. The ET column has the evapotranspiration for each
event. This is measured as the total evapotranspiration occuring
from the time of one event until just prior to the next event. All
of these values can be edited using standard Macintosh editing
techniques. See the "Boundary Condition..." section in Chapter 4
for more details.

Perform the simulation by choosing, appropriately enough, Run
from the Run menu. The spinning tetrahedron cursor will appear.
This will signal a coffee break for those who are owners of
MacPluses running multi-year simulations. You may abort any
simulation by holding down the command key (%) and typing a
period (.). A window showing the results of the simulation will
appear:
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]

L

Simulation Report ==

® |RR/PPT EVENT 1: TIME = O DAYS

Irrig/precip amount:
Irrig/precip conc.
Evapotranspiration :
Root penetration
Leaching fraction

8.500 cm
1.000 mg/|
S5.000 cm
90.000 cm
0.000

After irrig/precip (field capacity) simulation results:

Inc. Depth Hater Content Sol'n. Conc. Ads. Conc. Total Conc.
(cm? (em*3/em”3) (mg/1?> (mg/kg? (mg/cm”*3)
1 0.00- 15.00 0.300 0.900 0.00000 0.27000
2 15.00- 30.00 0.300 0.471 0.00000 0. 14135
3 30.00- 45.00 0.300 0.247 0.00000 0.07400
4 45.00- 60.00 0.300 0.129 0.00000 0.03874 7%
Kd IS

The window may be resized, zoomed and scrolled to view its full
extent. See the "Simulation Report” section in Chapter 4: Using
TETrans for more details. The window shows simulated values for
root depth, leaching fraction, soil water content; and solution,
adsorbed and total solute concentration for each of the irrigation
or precipitation events and soil profile depths.

¢ A variety of graphs of the simulation results can be viewed with

TETrans. To get a two-dimensional view of your simulation,
choose 2D Graph from the Qutput menu. This will display the
dialog window:

Display a 2D Graph Type: [ ([ 3

H-axis: | Depth

Y-auis:

Solution Concentration (At FC)

Pop-up menus allow you to select the x- and y-axis data to be
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displayed. Move the cursor over the "X-axis:" box and hold the
mouse button down to view the x-axis pop-up menu. Now, with

the mouse button still down, drag the cursor and select "Time" as
shown below:

Display a 2D Graph Type: I/: |_Z

H-axis:

Y-anis: ration (At FC)

Pore VDolume

Click on the "OK" button. A graph of the simulated solution
concentration values with time will appear:

1}

FC Soln. Conc. With Time

i

2.5

-0.0-15 cm
= 15-30 cm
030-45 cm
<©45-60 cm
©60-75 cm
.m; +75-90 cm
X 90-105 cm

JO—=+ Q3 ~A3MN3IO0OO

0.0 ; ; ; ;
0 20 40 60 80 100

Time [l
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NOTE: 2D graphs can display only up to seven curves. Close this
window by choosing Close from the File menu. A dialog window
will appear asking if you would like to save the graph to a file.
Click the "No" button, which dismisses the dialog window and
removes the graph.

To limit the number of curves displayed in a 2D graph, choose
Output Depths from the Qutput menu. A dialog listing all of
the available soil layer depths will appear:

Select depths for output:

0.00 - 15.00 cm ( setect AN )
15.00 - 30.00 cm
30.00 - 45.00 cm
45.00 - 60.00 cm_

60.00 - ?5.00 cm
75.00 - 90.00 cm [
90.00 - 105.00 cm

105.00 - 120.00 cm

Using the mouse, click on the line that reads "45.00 - 60.00 cm"
and drag downwards, holding the mouse button down as you go.
This will deselect all but the first three soil layers. The dialog
should now look like this:

Select depths for output:
0.00 - 15.00 ¢m ( setect AN )

15.00 - 30.00 cm
30.00 - <15.00 cm
45.00 - 60.00 cm
60.00 - ?5.00 cm
75.00 - 90.00 cm [

Cancel ]

5 d
I.“-l
———————

90.00 - 105.00 cm
105.00 - 120.00 cm

<




Click the "OK" button to dismiss the dialog. Now go back and select
2D Graph from the Qutput menu again. Select "Time" from the

" "X-axis:" pop-up menu, as before, and click on the "OK" button.
You will get the following graph:

FC Soln. Conc. Uith Time

-0.0-15 cm
= 15-30 cm
O030-45 cm

JO=r QT ~3MN3IOO

Time Fﬁi

which now displays simulated concentration values for only the
first 3 soil layers: 0-15, 15-30 and 30-45 cm.

For a rapid assessment of the overall simulation results, select 3D
Graph from the Qutput menu. As in the 2D Graph case, pop-up
menus allow you to select the axis values for output. Click "OK",
and a 3D graph of simulated solution concentration values with
time and depth will be displayed:
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]

L] = 3D 6raph ==———=M]
Solution Conc. (At FC)

X = Depth Y=Time Z=Conc.

(=)

Here the surface represents the solution concentration (z-axis) as
a function of both depth and time (x-axis and y-axis,

respectively). See the "3D Graph" section of Chapter 4: Using
TETrans for more information.

Quit the TETrans application by choosing Quit from the File
menu. A dialog will ask you if you would like to save the 3D
Graph window to a file. Choose "No". This dismisses the dialog,
and TETrans will finish quitting without saving the graph. A
"Save this window?" dialog will appear for each of the open

windows as the application closes down. Select "No" in response to
each.

This sample simulation has briefly covered some of the features
of TETrans, and it's approach to modeling solute movement. The
next step is to input the parameters particular to your scenario.
See Chapter 2: Introduction to TETrans for an overview of the

3-8



input needs of TETrans. Chapter 4: Using TETrans gives detailed
descriptions of entering input parameters, running the model, and
displaying the results.
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CHAPTER 4: USING TETrans

This chapter provides the user with a detailed description of each
function of TETrans' user-friendly I/O interface. The I/O interface is
the shell of TETrans through which the user enters input data, runs the
TETrans model simulation and selects the form (i.e., text report or
graphics display) of the simulation output.




STARTING TETrans

TETrans can be run from your hard disk or floppy disk. Follow the
steps in Chapter 1: Installing TETrans to, obviously, install TETrans on
your’ hard disk.

To start TETrans, open the TETrans folder by double-clicking on the icon.
Open TETrans by double-clicking on the TETrans icon. The TETrans
menu bar and an About TETrans box will appear. (Clicking the mouse
within certain locations of the About TETrans box can sometimes have
unusual effects). You are now ready to use TETrans. All I/O interactions
with TETrans are conducted through the use of the menu bar.

Alternatively, double-clicking on any file created by TETrans
(parameter file, report file, 2D graph file, etc.) will start TETrans and
load in that file.

THE FILE MENU

Use the File menu commands for starting a new TETrans input

parameter file, opening an existing parameter file, saving the current
parameters to a file, or viewing the name of the current input parameters
file. In addition, use the File menu commands for saving a Simulation
Report, Mass-Balance Report, 2D graph or 3D graph window, opening a
previously saved window, printing a window, and quitting TETrans.

New Parameters

Choosing New Parameters sets all of TETrans' input parameter values
to their initial or default values. A dialog will give you the chance to
save the current parameters if they have been modified since they
were last opened or saved, or if they have never been saved to disk.
Any open Boundary Condition or Soil pH spreadsheets will be closed.

Open Parameters...

Use this command to open an existing TETrans input parameter file.
A standard file opening dialog box will appear:
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S TETrans

[ Sample Parameters
D Site 6 Boron Params

e Mr. MegaB...

([ fject )

[ e )

( open ]
5| [ Cancel ]

Only TETrans parameter files will appear in the list of files. Open the
disk and folder that contains the parameter file you want, then double-
click on the file name to open it.

Save Parameters...

Using this command allows you to save the current input parameter
values to a disk file. A dialog box appears:

S TETrans

0y sample Parameters O Mr. Mega...
DY Site 6 Boron Params -
& TEfraas Lipet

fripe

>

Save model parameters as:

Site 6 Chloride Params Cancel

i

Select the disk and folder where you would like the file to be saved.
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Then type your parameter file name in the "Save As" box. The name
defaults to the last opened or saved parameter file, or "Untitled" if no

parameter file has been opened or saved. When you are finished click
the "Save" button.

Current Parameters

Choose Current Parameters when you want to see the name of the
parameter file that was last opened (using the Open Parameters...
menu command). A sub-menu will show the file's name, or "Untitled” if
no parameter file was opened.

Open... (3%80)

Choose this command when you want to open a previously saved
Simulation Report, Mass-Balance Report, 2D graph or 3D graph. Select
Open from the File menu, find the disk and folder of the file you wish
to open, and double-click on the file's name to open it.

Close... (W)

Use this command to close the active window. To close a window,
choose Close from the File menu. If you are closing a window that has

not been saved to disk, a dialog box will appear asking if you want to
save the window:

Save this window before
closing?

Cancel

Click "Yes" to save the window. A Save As dialog box will appear.
Type the name of your file in the "Save As" box and click "Save". See
"Save As" below for more information.

Click "No" to discard the window or click "Cancel" if you have changed
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your mind and don't want to close the window.
Save As... (%8S)

The ‘Save As command in the File menu lets you save the active
window to disk. A dialog box will appear. Select the disk and folder
where you would like the file to be saved. Type your file name in the
"Save As" box and click on the "Save" button. If the file name you type
already exists, an alert box will warn you and give you the chance to
change your file name.

Page Setup...
Use this command to set the print characteristics of your connected

printer. For example, choosing Page Setup with an Apple LaserWriter
attached will display the following dialog:

LaserlWriter Page Setup 52 [ 0K
Paper: ® US Letter (O A4 Letter (O Tabloid
QUSs Legal O BS Letter
Reduce or 1002 Printer Effects:
Enlarge: X Font Substitution?
Orientation X Text Smoothing?
N Xl Graphics Smoothing?
@ X Faster Bitmap Printing?

A variety of page size and print quality options can be set. Choosing
"OK" accepts any changes you make. The actual dialog you see depends
on the printer your are using. Consult your printer's documentation for
more details.

Print... (8P)

Choose Print to print the active window. The following dialog appears
if your printer is an Apple LaserWriter:
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LaserWriter “LaserWriter |1 NT” 52
Copies: ([l Pages:® Al O From: To:
Cover Page: @ No QO First Page O Last Page

/i

Paper Source: @ Paper Cassette (O Manual Feed

Cancel

Clicking the "OK" button starts the printing job. The actual dialog you
see depends on the printer you are using. Consult your printer's
documentation for more details.

Quit (%8Q)

Choose Quit when you wish to quit TETrans and return to the Finder. If
any unsaved windows are open, a dialog box will appear giving you a
chance to save each window before quitting.

THE EDIT MENU

The Edit menu only supports desk accessory editing. In the future it
will also support the editing of the spreadsheet windows, as well as the
copying of reports and graphs created in TETrans to and from the
Macintosh's clipboard. This will allow the copying of the simulation
results and graphs to your word processor or drawing programs. A
future Table item in the Qutput menu will allow the display of
TETrans' results in tables, which could then be copied to CricketGraph™
for graphing.

THE PARAMETERS MENU

Use the Parameters menu to enter values for the TETrans input
parameters, such as the soil bulk density, number of crops, etc.

The values entered here may be saved at any time using the Save
Parameters As... command in the File menu. See Chapter 2:
Introduction to TETrans for an overview of the physical meaning of the
less obvious input parameters.
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Depth Increments...

The Depth Increments command allows you to set the number and
thickness of each layer in your soil profile. When you choose this
command, the following dialog box appears:

Soil Profile Depth Increments

Number of depth increments: [15[3]

— Increment thickness

[Jvariable with depth  Bepth inevements [ |

Thickness: |10.000| cm

Cancel

Click on the up- or down-arrow buttons to change the number of soil
profile depth increments or layers in your profile. Then type in the
desired thickness in the "Thickness:" text box. Even if the soil is
homogeneous with no change in soil properties, you will still want to
enter more than one depth increment because the model simulation
output is based on the number and thickness of depth increments
entered in this dialog box. As a result, select how you want the solute
concentration distribution profile output to appear by entering the
number of depth increments and the constant thickness that each depth
increment will have. If your profile is divided into layers of varying
thickness, check the "Variable with depth” box. The dialog box will now
look like this:
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Soil Profile Depth Increments

Number of depth increments: [15[3]

— Increment thickness

X Variable with depth  Depth Increment: [ 1[3]

Thickness: |10.000{ cm

o)

The currently displayed soil profile depth increment is 1, it has a
thickness of 10.0 cm and there are a total of 15 separate layers or depth
increments. Fewer than 15 depth increments can be specified by using
the "Number of Depth Increments:" down arrow button. Click on either
the up or down "Depth Increment:" arrow button to change the

currently displayed depth increment. Using the "Depth Increment:" and
"Thickness:" text boxes, desired values for each of the depth increment's
can be entered. Clicking on the "OK" button dismisses the dialog and
accepts the values. Clicking "Cancel" dismisses the dialog without saving
the changes.

Hydraulics...

Choose Hydraulics to set the soil hydraulic parameters for your
simulation. A dialog box will appear:
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Soil Hydraulic Parameters

[J variable with depth Depth incrementc [ ]
Field-capacity soil water content: [0.3000| cm3/cm3
Minimum soil water content: 0.1000| cm3/cm3
Soil bulk density: 1.5000| g/cm3
Water bypass: 10.000| %

L tmmobile water ----------------------- S

..........................................................

Text boxes allow you to type in the needed hydraulic parameters for
each of the soil profile's depth layers or increments. These parameters
are the soil increment's field-capacity water content, minimum water
content, bulk density and percent of water bypass. See the "Input
Parameters” section in Chapter 2: Introduction to TETrans for a
discussion of these parameters.

By default, any parameter values you enter will apply to the entire soil
profile, unless you check the "Variable with depth" box. Checking the
"Variable with depth” box allows you to enter different values for each
of the depth increments in the soil profile:
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Soil Hydraulic Parameters

[X Variable with depth Depth increment:

Field-capacity soil water content: |0.3000| cm3/cm3

Minimum soil water content: 0.1000|] cm3/cm3

Soil bulk density: 1.5000| g/cm3

Water bypass: WA

trimahiie water

See the previous "Depth Increments" section to learn about how to set
the number and thickness of the the depth increments in your soil
profile. In the dialog shown above, the currently displayed values are
for the third depth increment. Click the "Depth increment:" up or down
arrows to select a particular depth increment, then type the hydraulic
parameter values in the text boxes.

The "Immobile water” text box is inactive (i.e., it appears grayed out).
This feature will be part of a future version of TETrans incorporating an
optional mobile-immobile phase solute transport model (see "Input
Parameters" section of Chapter 2: Introduction to TETrans).

Click "OK" to accept your entered values and to dismiss the dialog box.

Chemistry...

Use this command to select the type of solute you wish to model (e.g.
conservative ions, organic, etc.), as well as which chemical model for
TETrans to use in the simulation (e.g. linear adsorption, Langmuir
adsorption, etc.). When you choose Chemistry from the Parameters
menu you are shown the following dialog box:
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Chemical Parameters

Solute type: Conservative ions

Chemical model: Nonreactive

— Chemical model coefficients

[ sariable with depih Bepth incrementc [ [

Cancel

A pop-up menu for "Solute type:" allows you to select from conservative
ions, major salt ions, organics or inorganics. Holding the mouse button
down while the cursor is within the "Solute type:" box will reveal the pop-
up menu of solute types available. To make your selection, drag the
mouse with the button held down to the desired solute-type selection and
then release the button. For each of these selections there are one or
more possible chemical models that TETrans can use. Similarly, the pop-
up menu for the various chemical models available is shown when the
mouse button is held down while the cursor is within the "Chemical
model:" box. Selection of the desired chemical model is done the same as
for selecting the desired solute type, except only those chemical models
that are highlighted are available for that solute type. For conservative
ions there can be either the nonreactive model (e.g., chloride) or the anion
exclusion model. For major salt ions there is the cation exchange model.
For organics and inorganics there are the Freundlich (linear) and
Langmuir adsorption models. In addition, the Keren adsorption model is
included for the inorganic solute boron. For example, choosing Inerganic
from the Solute type pop-up menu, and Keren boron adsorption from
the Chemical model pop-up menu changes the dialog box to:
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Chemical Parameters

Solute type: Inorganic

Chemical model: Keren boron adsorption

blKyg(HB) + Kg(B)] g| e
1+ KHB(HB) + KB(B) + KOH(OH) * PHT c

x/m =

— Chemical model coefficients

[] Variable with depth Depth inceements [ [ |
Defaults

Adsorption maximum, b: 0.0000| mg/Kg

B(OH)4 affinity coefficient, Kg: 0.0000] 1/mg
B(0OH); affinity coefficient, Kyp: | 0.0000| I/mg
OH™ affinity coefficient, Koy: 0.0000| I/mg

The conventional description of the model's formula is displayed below
the pop-up menus. The coefficients for the particular model are
entered within the area labeled "Chemical model coefficients”. The text
boxes are where you enter the appropriate adsorption coefficients. In
this particular case, you type in values for the four Keren boron
adsorption coefficients: b, kg, kyg and koy. By default, any values you
enter will apply to the entire soil profile. Checking the "Variable with
depth” box allows you to enter different coefficient values for each of
the depth increments in the soil profile. This is done in the same
manner as for the hydraulic parameters, discussed above.

For the Keren boron adsorption model it is possible to assign default
values to these coefficients. Click the "Defaults” button to display the
following dialog box:




Select the soil texture to use
for setting the default Keren
model coefficients:

® Loamy sand

O Loam

(O Clay (low Fe203)
QO Clay (high Fe203)

Here boron adsorption coefficient values are set according to the
selected texture of the soil layer or entire soil profile. Click the
appropriate radio button for the most suitable soil texture: loamy sand,
loam, clay low in iron or clay high in iron. Then click the "Set" button to
apply these values. If "Variable with depth” is checked in the chemical
parameters dialog, these values will be applied only to the currently
selected depth increment.

When you have set your desired solute type, chemical model and
chemical model coefficients, click the "OK" button.

Plants...

Use this command to set the plant or crop characteristics for your
simulation. Three plant conditions are possible: no plant cover, natural
plant cover, or crops. No plant cover indicates fallow conditions.
Natural plant cover applies to areas of natural vegetative cover, such as
grasslands, chaparral, etc. Crops simply refers to man-planted crops.
Choosing Plants gives the following dialog:
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Plant Parameters

@® None
Plant cover: (O Natural

QO Crop

Number of c1raps:

Crap displaged: [ []

Man. ygaf deptn

Planting Gime:

Bays {6 maturity

Harpestling tme:

.........................

Plant water uplake:

K2l [

@ Linenr QO Luaponential

Here the plant cover is set to "None".

For this case, any

evapotranspiration entered in the Boundary Condition spreadsheet
(see "Boundary Condition..." subsection of this section) will be taken as
evaporation only from the surface of the soil.

Clicking the "Natural" plant cover button changes the dialog to:
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Plant Parameters

) O None .
Number of crgps:
Plant cover: (@ Natural ' D]

©) Crop Crap displaged: [ [ |

ant wateru .
Mas. root depth: (125 cm Pl ptake

ﬁLPPTHKE

Planting time; days

........................

bays {0 maturity

DEPTH

Harpesting tmer | L days

The plant cover's maximum root depth is entered in the "Max. root
depth:" text box. Entering zero for this value is the same as choosing no
plant cover.

Use the "Plant water uptake:" scroll bar to set the plant's root water
uptake profile. As you change the scroll bar's value, the bar graph will
show the amount of water taken up over the root profile. For instance,
the above graph shows a 40-30-20-10 uptake profile. This means that
40% of the plant's water uptake is in the upper one-fourth of it's root
zone, 30% in it's second, and so on. Clicking the "Linear” or "Exponential"
buttons changes the shape of the water uptake profile.

Clicking the "Crop" plant cover button changes the dialog to:
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Plant Parameters

O None
Number of crops: l: |§|
Plant cover: QO Natural Erop displs ed[-' 2 I3
@® Crop p displayed:
t -
Max. root depth: |90 cm Fiantuveter uptnke
% UPTAKE
) ) 50
Planting time: 100 days r
. - 27
Days to maturity: (45 E 15
Harvesting time: |300 days = 8

QO Linear @ Exponential

Use the "Number of crops:" up and down arrows to set the number of
crops to be used in your simulation. The crop parameters displayed in

the dialog are for the crop number indicated in the "Crop displayed:"
box.

In addition to the maximum root depth and uptake profile, each crop
must have its planting time, number of days to maturity and harvesting
time entered in the appropriate text boxes. To enter the next crop's
values, use the "Crop displayed:" up-arrow button to display the next
crop, then enter its values. At any time you may change the displayed
crop by clicking on the "Crop displayed:" up- or down-arrow buttons.
Click "OK" when you are through.

Initial Condition...

Use this command to set the soil profile's initial water content and
solute concentration. Choosing Initial Condition brings up the
following dialog:




Soil Profile Initial Condition

[] variable with depth Bepth increment: [ ]

Initial soil water content: 0.3000| cm3/cm3

Initial soil water solute concentration: (0.000 | mg/I

|| 0K !' |Cance||

Enter the initial soil water content, and the associated concentration of
the solute that you are simulating, in the appropriate text boxes.
Checking the "Variable with depth” box allows you to enter different
initial values for each of the depth increments in the soil profile. In this
way you can establish the initial soil water content and the initial solute
concentration profiles needed as the starting point for TETrans. This is
done in the same manner as for the hydraulic parameters, discussed
above. Click on the "OK" button when finished.

Boundary Condition...

Choose the Boundary Condition command to enter the soil surface
boundary conditions. These parameters describe the amount of water
and solute entering and leaving the surface of the soil over the course of
the simulation, and they are absolutely essential. Choosing this
command brings up a spreadsheet window:




Boundary Condition
Time (days) | Amount (cm) | Conc (mg/1)

| 0.000 £.500} 1.000}

wlo|~|o|on]|a|w|n]=|3|([]
Y
(]
[m ]
o
[¥s ]
on
(e}
[}
(]
(]
()}

]
=
o
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o
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a
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]
O
o
i
]
o

The first column is the number of the irrigation or precipitation event.
The time of an irrigation or precipitation event is entered in the Time
column. The amount of irrigation water applied or precipitation that
fell at this time is entered in the Amount column. The solute
concentration (of the solute being modeled only) of the irrigation water
is entered in the Conc column. Of course, for precipitation a
concentration of zero would be the most likely value. The
evapotranspiration is entered in the ET column. This is taken to be the
total amount of evapotranspiration occurring from the time of the
irrigation or precipitation event until just prior to the next event. For
example, the ET for event 3 would be the total amount of
evapotranspiration that occurred from the time of event 3 to the time of
event 4, a period of seven days in this case.

Use the arrow keys or mouse to select different cells or to move about
in the spreadsheet. The spreadsheet may be grown vertically to the full

extent of your screen.

NOTE: Make sure that the entered events are sorted in order of
increasing time. This version of TETrans will not sort them for you.

Soil pH...

This command is only available when the Keren model of boron
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adsorption is chosen, and is used to enter the soil pH values for each soil
profile depth increment of each irrigation event. Refer to the
"Chemistry..." subsection above to see how to choose the Keren chemical
model. Choosing the pH command brings up the spreadsheet:

=[] Soil pH =
% Inc 3 Inc 4 Inc 5 Inc6 >
0 7.000i  7.000 7.000 7.000
1 7.000 7.000 7.000 7.000
2 7000i  7.000 7000!  7.000
3 7.000: 7.000 7.000! 7.000
4 7000; 7000 7.000i - 7.000
=
6
7
8
9
& o

Each column, titled Inc 1, Inc 2, etc., corresponds to a soil profile depth
increment, as set in the "Depth increments..." section above. NOTE: The
first row, 0, is the initial pH distribution before any irrigations or
precipitations have occurred. This is an esssential inital condition for
the Keren boron adsorption model. The subsequent rows are the pH
distributions at field capacity following each irrigation or precipitation
event. Therefore, row 1 corresponds to irrigation or precipitation event
1, row 2 corresponds to event 2, and so on. (The values for irrigation or
precipitation amounts should have already been entered using the
Boundary Condition command from the Parameters menu). pH
values are set to a default value of 7, if you choose not to enter all of
the values.

THE RUN MENU

Run (8R)

Run starts the TETrans simulation, using the current input parameters.

4-19



A text window will appear with the simulation results for all of the
irrigation/precipitation events entered in the Boundary Condition
spreadsheet, and for all of the depths entered in the Depth
Increments dialog.

NOTE: Currently, the text windows showing the simulation results are
limited to 32K of text. If you find that the results for some of your
events are not shown in the Simulation Report window, use the Output
Depths and/or Output Times dialogs in the Qutput menu to limit the
amount of results displayed. Then choose Simulation Report from the
Output menu to make a new window with less text. This flaw will be
corrected in a future version.

To check the name of the current parameter file choose Current
Parameters from the File menu. A sub-menu will pop out with the

name of the current parameters (or "Untitled", if the current parameters
have not been saved).

You may abort any simulation before it is done by holding down the
command key (%) and typing a period (.).

THE OUTPUT MENU

Use the Output menu to create text reports showing simulation results
and mass-balance information, as well as to create two- and three-
dimensional graphs of simulation results and input values.

Output Depths...

Choose this option to select or limit the output depths for simulation
results displayed in the simulation report, mass-balance report and 2D
graph windows. Choosing Output Depths displays this dialog box:
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Select depths for output:

IHIESEHUNG B [ select All
15.00 - 30.00 cm -
30.00 - 45.00 cm
45.00 - 60.00 cm

60.00 - ?5.00 cm
(75.00 - 90.00 cm
90.00 - 105.00 cm

105.00 - 120.00 ¢m
|i 0K i]

The depth increments, set from the Depth Increments command in
the Parameters menu, are shown in a scrollable list. Clicking on any
given depth will select it for output. Clicking on it again will deselect it.
By clicking the mouse and dragging, multiple depths can be selected or
deselected. Clicking the "Select All" button selects all of the depths for
output. Clicking "OK" saves your selections and dismisses the dialog box.

Output Times...
Choose this option to select or limit the output times for simulation

results displayed in the simulation report, mass-balance report and 2D
graph windows. Choosing Output Times displays this dialog box:

Select times for output:

0 days 2 ( selectAll )
7 days

14 days
21 days
28 days
35 days
42 days
49 days
56 days
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The event times, from the events entered in the Boundary Condition
spreadsheet of the Parameters menu, are shown in a scrollable list.
Clicking on any given time will select that time for output. Clicking on it
again will deselect it. By clicking the mouse and dragging, multiple
times can be selected or deselected rapidly. Clicking the "Select All"
button selects all of the times for output. Clicking "OK" saves your
selections and dismisses the dialog box.

Simulation Report
Choose this option to get a listing of the simulated solute and water

content values from the most recently run simulation. Choosing
Simulation Report will display a window like this:

=[] =—————— Simulation Report #1 EIE
® IRR/PPT EUENT 1: TIME = O DAYS >
Irrig/precip amount: 8.500 cm []
Irrig/precip conc. 1.000 mg/l a3
Evapotranspiration : 5.000 cm

Root penetration : 90.000 cm

Pore Uolume - 0.118

Leaching fraction 1.000

After irrig/precip (field capacity? simulation results:

Inc. Depth Hater Content Sol'n. Conc. Ads. Conc. Total Conc.
Cem)d Cem”3/cm*3) tmg/l o <mglkgd ‘pgfem”3D
1 0.00- 15.00 0.200 0.800 0.00000 0.27000
2 15.00- 30.00 0.300 0.471 0.00000 0.14135
3 30.00- 45.00 0.300 0.247 0.00000 0.07400 (%
G L =

TETrans will create this window for you automatically after any
simulation. The results shown will be for the output times and depths
selected in the Output Times and Output Depths dialogs (see the
subsections above on "Output Times" and "Output Depths").

The following information is displayed for each irrigation (or
precipitation) event:
« Amount of irrigation water or precipitation

» Irrigation water concentration for the solute being modeled
« ET
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Depth of root penetration

Leaching fraction

Soil water content, solution concentration, adsorbed
concentration and total concentration following the irrigation or
precipitation. This is at the soil's field capacity water content and
the results are displayed for each depth increment selected for
output.

* Root water uptake, soil water content, solution concentration
and adsorbed concentration immediately before the next
irrigation or precipitation event. This is at the soil's most dry
state, after all of the ET occurs. The results are displayed for each
depth increment selected for output.

Simulation reports can be created at any time following a simulation.
By using the Output Times and Output Depths dialogs, simulation
results for any combination of event times and soil profile depths can
be displayed.

Simulation reports are saved as ordinary text files. See the "Save As"
subsection of the "File Menu" section above.

Currently, the window is limited to 32K of text. If you find that the
results for some of your events are not shown in the Simulation Report
window, use the Qutput Depths and/or Output Times dialogs in the
Output menu to limit the amount of results displayed. Then choose
Simulation Report from the Qutput menu to make a new window
with less text. This flaw will be corrected in a future version.

Mass-Balance Report

Choose this to obtain diagnostic information about the most recently run
simulation. Choosing Mass-Balance Report will display a window like
the one below:
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s ==————— Mass Balance Report #1 ———l=
& |NITIAL:

Initial soil water in soil profile = 36.0000 cm
Initial solute in soil profile = 0.0000 pgfcm™2

® |RR/PPT EVENT 1: TIME = O DAYS

Hater Balance: Solute Balance:
Hater In = §.5000 cm Solute In = 5.5000 pg/em™2
Hater Out: Solute Out = 0.0480 pgfem™2

ET = 0.0000 cm Stored:

Drainage = 8.3000 cm Solution = 8.4520 pgiem™2

Total = 0.0000 cm Adsorbed = 0.0000 pgfem™2
Stored = 36.0000 cm Total = §.4520 pgfem”2
Error §.5000 cm Error 0.0000 pgfem™2
<Al |

The water and solute mass-balance information for each irrigation (or
precipitation) event is displayed in a scrollable, resizeable window. The
water-balance information consists of the amount of water entering the
soil profile surface, the amount of water leaving the soil profile (through
drainage or ET) and the amount of water stored in the soil profile. The
solute-balance information consists of the amount of solute entering the
soil surface in the irrigation water, the amount leaving through
drainage, and the amount stored in the soil profile (in both the solution
and the adsorbed phases). Any appreciable error in either the water or
solute balance indicates a problem with the model parameters. See
Chapter 5: Troubleshooting TETrans for more information.

Mass-balance reports can be created at any time following a simulation.
The irrigation events for which the mass-balance information are listed
can be set using the OQutput Times command of the Qutput menu. See
the subsection above on "Output Times" to see how to do this.

Mass-Balance reports are saved as ordinary text files. See the "Save As"
subsection of the "File Menu" section above.

Currently, the window is limited to 32K of text. If you find that the
results for some of your events are not shown in the Mass-Balance
Report window, use the Output Times dialogs in the Qutput menu to
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limit the amount of results displayed. Then choose Mass-Balance
Report from the Output menu to make a new window with less text.
This flaw will be corrected in a future version.

2D Graph...

Use this command to create a two-dimensional graph of the simulation
results, input parameters or mass-balance results. When you choose 2D
Graph, the following dialog box appears:

Display a 20 Graph Type: l/: rz

H-auis: | Depth

¥-anis: | Solution Concentration (At FC)

Icons representing a normal or a 90° rotated x-y graph appear in the
upper-right corner. Click on the icon of the desired type to select it.
The 90° rotated type is nice for graphing results that are a function of
depth.

The "X-axis" pop-up menu allows you to select from "Depth”, "Time" or
"Pore Volume" for the x-axis variable. Holding the mouse button down
while the cursor is within the "X-axis:" box will allow you to view the
pop-up menu. To make your selection, drag the mouse with the button
down to the desired x-axis selection and then release the button. The
"Y-axis" pop-up menu allows you to select from a variety of simulation
variables, such as solution concentration, adsorbed concentration, total
ET, etc. Follow the same steps to view and select the y-axis as you did
for the x-axis. For example, choosing "Depth" as the the x-axis variable
and "Solution Concentration (At Field Capacity)" as the y-axis variable,
then clicking the "OK" button, creates a graph like the one below:

4-25



= 2D Graph #1 |
_ 2 50 Solution Concentration ¢(mg/l) with Depth ¢cm) - FC
2.00
B g -0 Days
2 9 =0 = 7 Days
ﬁ ' o 14 Days
:.;. <21 Days
a
} 1.00 028 Days
- o +35 Days
) x 42 Days
= 0.50
- 0.00 i i T I
0.0 20.0 40.0 60.0 80.0 100.0 120.0
Depth r@|

The actual values depend on your simulation parameters, of course.

= The number of curves displayed in a graph depends on the y-axis
variable and the output times and depths chosen in the Output Times
or Output Depths dialogs (see the "Output Times" or "Output Depths"

= sections above).

The window can be resized by clicking on the grow icon in the upper-
right corner of the window or by using the mouse to drag the resize icon

in the lower righthand corner.

2D graphs are saved in a unique format that only TETrans can read. See

the "Save As" subsection of the "File Menu" section above.
s version of TETrans will allow saving graphs as PICT files, as well as

copying graphs to the clipboard for export to other applications.

- 3D Graph...

Use this command to create a 3D graph of the simulation results.

The next

A 3D
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graph can give the you a quick assessment of the movement and
distribution of the solute through time. When you choose 3D Graph, the
following dialog box appears:

z

XJ_-Y Display a 30 Graph [m]
H-axis: Depth

y-anis: | Time

2-axis: | Solution Concentration (At FC)

This dialog is used to set which variables are used for each of the 3D
graph's axes. The "X-axis" variable is the soil depth. The "Y-axis" pop-
up menu allows you to choose from "Time" or "Pore Volume" for the y-
axis variable. Holding the mouse button down while the cursor is
within the "Y-axis:" box will allow you to view the y-axis pop-up menu.
To make your selection, drag the mouse with the button down to the
desired y-axis selection and then release the button. The "Z-axis" pop-
up menu allows you to choose from a variety of simulation variables for
the z-axis variable, such as solution or adsorbed concentrations, water
uptake, etc. View and select the desired "Z-axis" just as you did for the
y-axis. Click the "OK" button to dismiss the dialog box and create the
graph. For example, the graph below was created choosing "Time" for
the y-axis and "Solution Concentration (at Field-Capacity)" for the z-axis:
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The view point is positioned 45° above the x-y plane. The 3D-graph can
be rotated by using the controls on the left-hand side of the graph
window. In addition, slices of the graph along the x- or the y-axis and
freely-suspended or enclosed 3D graphs can be selected. The window
can be resized by clicking on the grow icon in the upper righthand
corner of the window or by using the mouse to drag the resize icon in
the lower righthand corner.

3D graphs are saved in a unique format that only TETrans can read. See
the "Save As" part of the "File Menu" section above. The next version of
TETrans will allow saving graphs as PICT files, as well as copying graphs
to the clipboard for export to other applications.
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CHAPTER S: TROUBLESHOOTING TETrans

This chapter provides some "preventative medicine” for reducing the
chance of problems occuring with TETrans and an explanation of the
internal error messages which are specific to the operation of
TETrans.




GENERAL SUGGESTIONS

Within TETrans there are built-in error messages which are
generated when physically impossible results are calculated (e.g.,
negative adsorption). Most error messages are sufficiently self-
explanatory to be understood by the user. However, some messages

are cryptic and need further discussion (see the "Error Messages"
section of this chapter).

A few "preventative medicine" suggestions which can either prevent
problems from occurring or help in the detection of problems are
provided:

1. In some instances, the estimated plant input parameters
may be incompatible with the entered evapotranspiration
amounts. This will result in the loss of water mass balance.
To check that this is not occurring, a mass-balance text
report should be generated for each simulation. If a loss of
water mass balance does occur, then the root water uptake
distribution, minimum water content, field capacity
and/or maximum root penetration depth are all suspect. To
correct the mass-balance problem, adjust these parameters
until mass balance is maintained. The maximum root
penetration depth and the root water uptake distribution
are the most likely parameters to be in error.

2. Because TETrans does not model upward water flow,
situations where evapotranspiration significantly exceeds
irrigation or precipitation can present problems. Under
irrigated agriculture, evapotranspiration will seldom exceed
the amount of irrigation. However, under dry land farming
conditions or natural landscapes where precipitation is the
primary source of water, evapotranspiration can
significantly exceed precipitation. This will generate error
messages by the TETrans' code and result in program
termination. If it is believed that upward water flow is not
significant, then the user can short circuit this problem by
summing the evapotranspiration and precititation data over
several precipitation and evapotranspiration events until
the difference between the two no is longer substantial.
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(NOTE: A precipitation event is considered to be each day
that precipitation occurs, while an evapotranspiration event
is considered to be the evaporation that occurs between
successive precipitation events).

ERROR MESSAGES

ERROR: Divergence in Newton-Raphson Method.
Corrective action: Check the Freundlich adsorption coefficients
for their correct values. If the Freundlich values are
correct, then the error tolerance in the source code may

be set too low. Call technical support for advice.

ERROR: Improbable scenario.
No adsorption & water content depleted to 0.

Corrective action: This error indicates that the user has
selected parameters such that no adsorption is permitted,
yet the water lost from an evapotranspiration event has
depleted one of the soil layers to 0 which, of course,
would force adsorptioninto occurring. Obviously, there is
a dilemma. To correct this problem, change the minimum
water content to greater than 0. A value of 0.05 to 0.16
cm3/cm3 is most probable. If the minimum water
content is already greater than 0 and less than the field
capacity water content, then call technical support for
advice.

ERROR: Insufficient water in column to meet ppt.
event ET requirements.

Corrective action: The evapotranspiration is causing water to
be removed below the minimum water content. Either
lower the evapotranspiration amount for this event or
lower the minimum water content. The latter is most
preferred.

ERROR: Invalid entry.
Corrective action: An entry is not valid, so check the input
parameters.
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ERROR: Invalid ET model.
Check rootflg variable.

Corrective action: Call technical support and provide them with
the evapotranspiration model which was selected.

ERROR: Invalid piston flow/mixing entry.
Entry defaulted to 1.

Corrective action: This error refers to the percent water
bypass. A value between 0-100% should have been
entered. The entry has defaulted to complete piston-type
flow which is a percent water bypass of 0%.

ERROR: Invalid printout flag.
Check prntflg variable.
Corrective action: Call technical support for advice.

ERROR: Lack of convergence in Newton-Raphson
method. ‘

Corrective action: The error tolerance is probably set too low.
Call technical support for advice.

ERROR: Negative water uptake.
Inappropriate water uptake model selection.

Corrective action: Select an alternate plant water uptake model
(choice of linear or exponential). If this fails, then adjust
the maximum root penetration depth or the root water
uptake distribution. Check the evapotranspiration values
to see that they are not significantly exceeding the
irrigation/precipitation amounts. If there is a significant
difference between the irrigation/precipitation amounts
and evapotranspiration amounts, then follow the
suggestion outlined as corrective action for the error:
"Precipitation event has insufficient H20 to bring column
to field capacity." If all else fails, call technical support
for advice.

ERROR: Newton-Raphson approximation is less than 0.

Corrective action: The error tolerance is probably set too low
or the bisection method is not functioning correctly. Call
technical support for advice.
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ERROR: Precipitation event has insufficient H20 to
bring column to field capacity.

Corrective action: This error may occur when a low amount of
precipitation or irrigation is associated with an
evapotranspiration event which is high relative to the
irrigation/precipitation amount. A way of dealing with
this is to add successive precipitation/irrigation and
evapotranspiration events:

For example:

Irrigation Event # Irrigation Amount ET Amount
(cm) (cm)
50 3.50 2.75
51 0.01 0.50
a2 4.00 2.00
53 275 1.0
CHANGE TO
Irrigation Event # Irrige{tion Amount ET Amount
(cm) (cm)
50 3.50 215
51 4.01 2.50
52 2.75 1.0

NOTE: Technical support phone numbers are Dennis Corwin (714)
369-4819 and Bart Waggoner (714) 369-4875.

o



APPENDIX A - Notation

o1 = linear plant root disrtibution coefficient

((1<or<1)

Ol = exponential plant root distribution coefficient
(02>0)

Y = mobility coefficient, or more specifically, the

fraction of Vg which is subject to piston-flow
(where, 0 <Y< 1, Y= O represents total bypass,

Y =1 represents complete piston-type flow)

1.0-v = fraction of Vg which is bypassed

Pb = soil bulk density (kg/m3)

Y = soil-water suction head (m)

Bg = volumetric water content immediately before an
irrigation (cm3/cm3)

Oic = volumetric water content at field capacity
(cm3/cm3)

a =Q0a/L

b = Langmuir adserption maximum (mg/kg)

Cag = adsorbed solute concentration (kg/m3)

Cal = concentration of solute in the soil water after an
irrigation (kg/m3)

Cgi = concentration of solute in the soil water

immediately before an irrigation (kg/m3)
Cic = concentration of solute in the soil water at field

apacity (kg/m3)

Cin = solute concentration of the entering water
(kg/m3)

Cout = solute concentration of the exiting water (kg/m3)

g(z) = root distribution function

k = Langmuir affinity adsorption coefficient (L/mg)

L = plant root penetration depth (m)

r(y) = reducing factor

S(y,z) = volumetric root extraction function

Ta = integral of the volumetric extraction function

from the soil surface (z = 0) to the depth of root
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penetration (z=L)

Tad = total amount of adsorbed solute in Vi (kg)

TAl = total amount of solute in a volume, Vi, of soil after
an irrigation (kg)

Tg = total amount of solute in a volume, Vi, of soil
immediately before an irrigation (kg)

Tin = total amount of solute entering Vi (kg)

Tout = total amount of solute leaving Vi (kg)

Tp = potential volumetric transpiration (m3)
Tsw = total amount of solute in the soil water of Vi (kg)
Ui(z) = relative water uptake over the soil depth interval
Z1 to zo for a linear root distribution
Ue(2) = relative water uptake over the soil depth interval
z1 to zo for an exponential root distribution

Val = volume of soil water in Vi after an irrigation (m3)

Vg = volume of soil water in Vi immediately before an
irrigation (m3) = 0| Vi

Vie = volume of water in Vi at field capacity (m3) = O4.Vy

Vin = volume of water entering Vi (m3)

Yisins = minimum volume of soil water in Vi (m3)

Vout = volume of water leaving V; (m3)

Vi = a unit volume of soil within the depth interval zq
to zo (m3)

x/m = adsorbed concentration of the Langmuir adsorption
isotherm (mg/kg)

z = soil depth with zero at the soil surface and

positive downward (m)
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APPENDIX C - MPW Fortran Source Code

Only the transport model source code is provided. The I/O.interface
code is excluded since it is not regarded as essential in helping the
user understand the model.
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!'"M Inlines.f

subroutine TET1SUB (err)

common irrdate, irramt, et, ciw, ph, sph, zz, fc, h2omin, %k, q,
rho, sh2o0, csw, cad, ctotal, khb, kb, koh, gph, kf, nf,
pdate, mdate, hdate, alpha, rpmax, gamma, watup,
total, h2o0in, h2oo0ut, cin, cout, starthZo, startsol,
excess, watcon, solcon, rp, uptake, cbi, aa, beta, a,
temp, zl, 22, reluptake, h, oh, b, hb, kchb, kcb,
kcoh, kecg, rootl, root2, root3, mgl, mg2, mg3, phi,
collen, initsol, inith2o0, totet, totdrain, toth2oin,
tothZ2o0ut, 1f, storeh2o, totsolin, totsolout, totsolst,
totad, totsoln, avefc, avesat, fcpv, satpv, errhlo,
errsol, 3jjj, 33jjij, out, printin, nirr,
site, treat, ncomp, ncrop, irr, crop, i, I, unitno,
prnt, diskno, loop, chemmdl, phflg, soil,
kacflg, rootflg, border, fileinput, filename, ht,
printout, jread, mbflg, htitle

bk whHOoJdO U b W

implicit real*8 (a-h)
implicit real*8 (p-z)
implicit integer*4 (i-o)

real*8 irrdate(100), irramt(100), et(100), ciw(100), phi (50},
ph(25,100), sph(25), zz(25), fc(25), h2omin(25), k (25},
g(25), rho(25), sh2o0(25), csw(25), cad(25), ctotal(25),
khbi{25), kby(25), koh(25), gph(25), kf (25), uf (25},
pdate (25), mdate(25), hdate(25), alpha(25), rpmax(25),
gamma (25), watup(25), total(25), h2c0in(25),
h2c0ut (25), c¢cin(25), cout(25), starth2o(25), startsol (25),
excess, watcon, solcon, rp, uptake, cbi, aa, beta, a, temp,
zl, z2, reluptake, h, oh, b, hb, kchb, kcb, kcoh,
kcqg, rootl, root2, root3, mgl, mg2, mg3, collen, initsol,
inith20, totet, totdrain, toth2oin, toth2oout, 1f,
storeh2o0, totsolin, totsolout, totsolst, totad, totsoln,
avefc, avesat, fcpv, satpv, errh2o, errsol

WNHROOJOTO W

integer*4 333, jjjj, out, printin, nirr, site,
treat, ncomp, ncrop, irr, crop, i, Jj, unitno, prnt,
diskno, loop, chemmdl, phflg, soil, kacflg,
rootflg(25), printout, Jjread, mbflg, errnum

w N

character htitle*77, border*56, fileinput*20, filename*20, ht

C *** Following 2 lines added for Mac version:

oo

integer*4 err
cexternal AnimCursor

*hkKkk*k Variable Definitions ** *xkkxkx A x A kAKX AKX A AKX AR KA IR XTI FA XA A K KX LK

irrdate = irrigation date irramt = irrigation amt.
et = evapotranspiration ciw = conc. of irr. hZo
ph = pH of each compartment sph = starting pH

zz = depth increment fc = field capacity
hZ2omin = min. h20 content kX = Langmuir K

g = Langmuir max. ads. rho = bulk density

sh2o = h20 con. before each ppt. c¢sw = conc. in soil h2o
cad = adsorbed conc. ctotal = cmpt. total conc.
gph = Keren pH model max. ads. khb = B(OH)3 affinity coef.
kb = B(CH)4 affinity coef. koh = (OH-) affinity cocef.
pdate = planting date mdate = maturing date
hdate = harvest date alpha = root descriptor

rpmax max. root penetration gamma = piston/mixing term
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watup = % plant H20 uptake

total = total solute/cm”™3 h20in = H20 entering cmpt.
h2o0out = H20 leaving cin = solute conc. entering
cout = solute conc leaving excess = excess cmpt. H20
watcon = sh2o0 / zz solcon = CsW

rp = root penetration uptake = ET in a compartment
cbi = conc before irrig. z1l & z2 = depth indicators
reluptake = rel. uptake h = [H+]

oh = [0H-] b = [B(OH) 4]

hb = [B(OH) 3] rootl = alpha / (rpmax)"2
root2 = alpha / rpmax root3 = 1 / rpmax
mgl,mg2,mg3 = convert units collen = soil column length
initsol = init. total solute conc. in soil column

inith20 = initial total H20 in soil column

totet = cumulative ET totdrain = total drainage
toth20in = total H20 applied tothZoout = totet+totdrain

1f = runnign leaching fraction storehZo = H20 stored in col.
totsolin = total solute applied totsolout = tot. sol. drain.
totsolst = total solute stored totad = total solute adsorb.
totsoln = total solute in soln. avefc = ave. col. field cap.

avesat = ave. col. saturation fcpv = pore vol. (field cap)
satpv = pore vol. (saturation) errh20 = mass bal. H20 error
errsol = mass bal. solute error starthZ2o = start. h2o content
startsol = starting sol. conc. mbflg = mass balance flag
cmpt = cmpts. of output data 333 = counter

33Jj = counter out = output device

printin = screen printout flag nirr = no. of irrigations
endirr = ending irrigation ncreoep = no. of crops

ncomp = no. of compartments irr = irr. event counter
crop = crop counter i & j = counters

unitno = terminal no. prnt = printer device no.
diskno = disk unit no. endmess = error mess. flag
loop = main loop counter chemmdl = chem. model flag
phflg = ph flag scil = soil type flag

kacflg = Keren affin. coef. flag rcocotflg = root model flag
fileinput = input file filename = output file name
ht = horizontal tab printout = printout flag

phi = Newton-Raphson estimate jread = flag to read input
prntflg = printout flag htitle = title heading

C')O(‘)OOOOOOOOOOOOOOOOOOOOOOGOOO(’)OOOOOOQOOQ

FhEAhhkhhkhkhkkhkhhkhhk kA A ddAhhkAh Ao dhdhhhhhhhkdhhhbhkhkhhhkhhhhkhhkhkhkhkkkkkkhkkkhkhkkdk

C #adkdxxxxy Put up the cursor
call AnimCursor ()

c ****% Variable Assignment and Initialization
j=20
out = 3
nirr =
site =
treat
ncomp
ncrop
irr =
crop = 0
chemmdl = 0
phflg = 0
soil =1
kacflg = 1
printin = 0
printout = 1
unitno = 6
prnt = 9
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diskno = 7
jread = 2
errnum = (0
mbflg = 0

mat irrdate = 0.0
mat irramt = 0.0
mat et = 0.0
mat ciw = 0.0
mat ph = 7.0
mat sph = 7.0
mat phi = 0.0
mat zz = 0.0
mat fc = 0.0
mat hZ2omin =
mat k = 0.
mat g = 0
mat rho =
mat shZo = 0.0
mat csw
mat cad
mat ctotal = 0.0
mat khb
mat kb = 0.0
mat koh
mat gph
mat kf = 0.
=0

It
oo
oo

Il
o
o

mat nf =
mat pdate
mat mdate
mat hdate
mat alpha
mat rpmax
mat rootfl
mat gamma
mat watup
mat total
mat h2oin
mat h2cocut = 0.0
mat cin = 0.0
mat cout = 0.
mat starth2o
mat startsol
excess 0.0
watcon 0.0
solcon
rp = 0.
uptake
cbi = 0.0
zl =

11 I

/I (e
cooOoH ||oocoooO
COCONOODOOO

Il

o

(el e
o o

ol nn

kcg = 0.0
collen = 0.0
imifgel =
inith2o =
totet = 0.

:TETrans-Mac:Tetransl sub.f
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totdrain = 0.0
toth2o0in = 0.0
toth2o0ut = 0.0
1f = 0.0
storeh2o = 0
totsolin = 0
0

[eNe]

0.0
.0

totsolout =
totsolst =
totad = 0.0
totscoln = 0.0
avefc = 0.0

& Unit Conversion Factors for Keren Model (ml/mg to l/moles)
mgl 1.0 / 61.835
mg2 1.0 / 78.843
mg3 1.0 / 17.008

C *** Call input subroutine - reads previously created input file into memory
call inroutine (err)

G Determine the starting adsorbed conc. (cad) in mg/kg from
C the starting soln. conc. (csw) in mg/l
do 770 i=1,ncomp

C ## No adsorption
if (chemmdl.eqg.l) then
cad(i) = 0.0
C ## Langmuir chemical adsorption model
else if (chemmdl.eqg.2) then
if (csw(i).eq.0.0) then

cad(i) = 0.0
else
cad(i) = (k(i)*g(i)*csw(i)) / (1.0+k(i)*csw(i))
end if :
C ## Keren boron adsorption model

else if (chemmdl.eq.3) then
if (csw(i).eqg.0.0) then
cad(i) = 0.0
else
alphal = (10.0**9.15) / (10.0**sph(i))
betal = (koh(i) * (10.0**sph(i))) /
1 (10.0**14.0)
b = (csw(i)/10811.0) / (1.0+alphal)
hb = b * alphal
cad(i) = (gph(i)* ((khb(i)*(1.0/mgl)*hb)+
(kb(i)*(1.0/mg2)*b))) / (1.0+
khb(1)* (1.0/mgl) *hb+kb (1) *
(1.0/mg2) *b+(1.0/mg3) *betal)

w N

end if
else if (chemmdl.eg.4) then
if (csw(i).eq.0.0) then
cad(i) = 0.0
else
cad(l) = kf(i) * (csw(i)**nf(i))
end if
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end if
770 continue

Convert inputted water contents to volumes, calculate total solute
in column at start, calculate total soil column length, and determine
initial H20 and solute in soil column
do 780, i=1,ncomp
"starth2o0(i) = sh2o (i)
startsol (i) = csw(i)
sh20(i) = sh2o(i) * zz (i)
fc(i) = fc(i) * zz (i)
h2omin(i) = h2omin(i) * zz (i)
ctotal (i) = sh2o(i) * csw(i) + rho(i) * zz (i) * cad(i)
collen = collen + zz (i)

[oNeNe!

inith20 = inith2o0 + sh2o(i)
initsol = initsol + ctotal (i)
780 continue
initsol = initsol / collen

C *** Create and open the output file:
open (99, file='TETRANS1.OQUT', status="'new')

C TOP OF MAIN LOOP
do 1000 irr = 1, nirr

C *****x*xx%x* Rotate the cursor
call AnimCursor ()

C *******x** Check for command-. or command-g presses
call CheckAbort (err)
if ( err .ne. 0 ) leave

C Advance Crop Counter, If Appropriate
if (crop.lt.ncrop) then
if (irrdate(irr) .ge.pdate(crop+l)) crop = crop + 1
end if

c Call Root Growth Subroutine
call rootgrow(err)
if ( err .ne. 0 ) leave

C Call Irrigation Subroutine
call irrigation(err)
if ( err .ne. 0 ) leave

C ***%*xx*x*%* Save after irrigation results to file:
call savedatl ()

C **x*x*%*%x*x** Rotate the cursor again
call AnimCursor ()

C Call Root Water Uptake Subroutine
call evapotran(err)
if ( err .ne. 0 ) leave

C **x*x*x*x**%* Sgve after et results to file:
call savedat?2()

1000 continue

C *#** Restore the arrow cursor
call InitCursor
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C *** Close output file:

C **%

close (99)

Was there an error?

if ( err .ne. 0 ) call errmess (err,irr)
return

end

***** Root Growth Subroutine

subroutine rootgrow (err)

common

ibWNhHOUO~IOYTUT B WN

implici
implici
implici

real*8

WNRPR ORIV W R

integer
integer

1

2

3
charact

## Root
if (irr
rp
else if
rp
else

rp

irrdate, irramt, et, ciw, ph, sph, zz, fc¢, hZomin, k, g,
rho, sh2o, csw, cad, ctotal, khb, kb, koh, gph, k£, nf,
pdate, mdate, hdate, alpha, rpmax, gamma, watup,

total, h2oin, h2cout, cin, cout, starth2o, startsol,
excess, watcon, solcon, rp, uptake, c¢bi, aa, beta, a,
temp, zl1l, z2, reluptake, h, oh, b, hb, kchb, kcb,

kcoh, kcqg, rootl, root2, root3, mgl, mg2, mg3, phi,
collen, initsol, inith2o0, totet, totdrain, toth2o0in,
tothZoout, 1f, storeh2o0, totsolin, totsolout, totsolst,
totad, totsoln, avefc, avesat, fcpv, satpv, errhZo,
errsol, 33j3j, Jjjj, out, printin, nirr,

site, treat, ncomp, ncrop, irr, crop, i, j, unitno,
prnt, diskno, loop, chemmdl, phflg, soil,

kacflg, rootflg, border, fileinput, filename, ht,
printout, jread, mbflg, htitle

t real*8 (a-h)
t real*8 (p-z)
t integer*4 (i-o)

irrdate (100), irramt(100), et (100), ciw(100), phi (50),
ph(25,100), sph(25), zz(25), fc(25), h2omin(25), k25,
q(25), rho(25), sh2o0(25), csw(25), cad(25), ctotal(25),
khb (25), kb{Z5), keh(25), gph(25), k£(25), nf(25);

pdate (25), mdate(25), hdate(25), alpha(25), rpmax (25),
gamma (25), watup(25), total(25), h2cin (25),

h2oout (25), c¢in(25), cout(25), starth2o(25), startsol (25),
excess, watcon, solcon, rp, uptake, cbi, aa, beta, a, temp,
zl, z2, reluptake, h, oh, b, hb, kchb, kcb, kcoh,

kcq, rootl, root2, root3, mgl, mg2, mg3, collen, initsol,
inith20, totet, totdrain, toth2oin, toth2oout, 1f,
storehZo, totsolin, totsolout, totsolst, totad, totsoln,
avefc, avesat, fcpv, satpv, errh2o, errsol

*4 err

*4 333, 33Jj, out, printin, nirr, site,

treat, ncomp, ncrop, irr, crop, i, j, unitno, prnt,
diskno, loop, chemmdl, phflg, soil, kacflg,
rootflg(25), printout, jread, mbflg

er htitle*77, border*56, fileinput*20, filename*20, ht

penetration determination

date (irr) .ge.hdate(crop)) then

= 0.0
(irrdate(irr).ge.mdate(crop)) then
= rpmax (crop)

Il

rpmax(crop)*(irrdate(irr)—pdate(crop))/(mdate(crop)

6
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1 - pdate (crop))
end if

return
end

***** Irrigation Subroutine
subroutine irrigation(err)

common irrdate, irramt, et, ciw, ph, sph, zz, fc¢, hZomin, k, g,
rho, sh2o0, csw, cad, ctotal, khb, kb, koh, gph, kf, nf,
pdate, mdate, hdate, alpha, rpmax, gamma, watup,
total, h2o0in, h2cout, cin, cout, starth2c, startsol,
excess, watcon, solcon, rp, uptake, cbi, aa, beta, a,
temp, zl, z2, reluptake, h, oh, b, hb, kchb, kcb,
kcoh, kcg, rootl, root2, root3, mgl, mg2, mg3, phi,
collen, initsol, inith2o0, totet, totdrain, tothZoin,
toth2o00ut, 1f, storeh2o0, totsolin, totsolout, totsolst,
totad, totsoln, avefc, avesat, fcpv, satpv, errhZo,
errsol, jjj, Jjjj, out, printin, nirr,
site, treat, ncomp, ncrop, irr, crop, i, Jj, unitno,
prnt, diskno, loop, chemmdl, phflg, soil,
kacflg, rootflg, border, fileinput, filename, ht,
printout, jread, mbflg, htitle

Nk WNhNhHFEFOVWOIUTE W

implicit real*8 (a-h)
implicit real*8 (p-z)
implicit integer*4 (i-o0)

real*8 irrdate(100), irramt(100), et (100), ciw(100), phi(50),
ph(25,100), sph(25), zz(25), fc(25), h2omin(25); k({(25),
q(25), rho(25), shZo(25), csw(25), cad(25), ctotal(25),
khb (25), kb(25), koh(25), gph(25), kf(25), nf(25),
pdate (25), mdate (25), hdate(25), alpha(25), rpmax(25),
gamma (25), watup(25), total(25), h2o0in(25),
h2oo0ut (25), cin(25), cout(25), starth2o0(25), startsol(25),
excess, watcon, solcon, rp, uptake, cbi, aa, beta, a, temp,
zl, z2, reluptake, h, oh, b, hb, kchb, kcb, kcoh,
kcqg, rootl, root2, root3, mgl, mg2, mg3, collen, initsol,
inith20, totet, totdrain, tothZoin, toth2ccut, 1f,
storeh20, totsolin, totsolout, totsolst, totad, totsoln,
avefc, avesat, fcpv, satpv, errhZ2o, errsol

WNHYuyoJo kW H

integer*4 err

integer*4 j3jj, Jjjj, out, printin, nirr, site,

1 treat, ncomp, ncrop, irr, crop, i, Jj, unitno, prnt,
2 diskno, loop, chemmdl, phflg, soil, kacflg,

3 rootflg(25), printout, jread, mbflg

character htitle*77, border*56, fileinput*2Q0, filename*20, ht

## Add to total applied ppt (cm):
tothZo0in = toth20in + irramt (irr)

## Add to total applied solute (ug/cm”2):
totselin = totsolin + ciw(irr) * irramt(irr)

## Initial conditions
h20in(l) = irramt (irr)
cin(l) = ciw(irr)

Page
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storeh20 = 0.0
totsoln = 0.0
totad = 0.0

totsolst = 0.0

& ## Loop through each increment and mix:
do 2000 i=1, ncomp

C ## Error check:
if (h20in(i) .1t. 0.0) then
err = 1
return
end if
(o ## Calc total solute in increment before the irrigation:
cbi = sh2o(i)*csw(i)+zz(i)*rho(i)*cad(i)
C ## After irrig mixing. If complete bypass (gamma = 0), do following:
if (gamma(i) .eg. 0.0) then
(0 ## Insufficient ppt to reach field capacity:
if (h2cin(i) .le. (fc(i) - sh2c0(i))) then
h2c0ut (i) = 0.0
cout (i) = 0.0
sh2o0 (i) = h20in(i) + sh2o(i)
G ## Sufficient water:
else
h2coout (i) = h20in(i) - fc (i) + sh2o(i)
cout (i) = ((gamma (i) *csw(i)*sh20(i))-(cin(i)*fc(i))+
1 (cin(i)*h20in(i))+((1.0-gamma (i) ) *cin(i)*
2 sh20 (1)) ) /h200ut (i)
sh20 (i) = fc (i)
end if
C ## Otherwise, for gamma between 0 and 1 do the following:
else if (gamma(i) .gt. 0.0 .and. gamma(i) .le. 1.0) then
C ## Insufficient ppt to reach field capacity:
if (h2o0in(i) .le. (fc(i) - sh20(i))) then
hZ2oout (i) = 0.0
cout (i) = 0.0
sh20(i) = h2c0in(i)+sh2o(i)
else if ((h2c0in(i) .gt. (fc(i)-sh2o0(i))) .and.
i (hZoin(i) .le. (fc(i)-((l1.0-gamma (i))*sh2o(i))))) then
h2oout (i) = h2c0in(i) - fc(i) + sh2o(i)
cout (i) = csw(i)
sh2o0(i) = fc (i)
else
hZ2oo0ut (1) = h20in(i) - fc (i) + sh2o(i)
cout (i) = ((gamma(i)*csw(i)*sh2o0(i))-(cin(i)*fc(i))+
1 (cin(i)*h2o0in(i) )+ ((1.0-gamma (i) )*cin(i)*
2 sh2o0 (1)) ) /h2oc0ut (i)
sh2o0(i) = fc (i)
end if
end if
c ## Total solute in increment after irrigation (=stored+inputs-outputs)
cal = cbi + h20in(i)*cin(i) - h2oout (i) *cout (i)
C # Round-off error correction:

if ((cin(i) .eq. 0.0) .and. (cai .lt. 0.0) .and. (chemmdl .eqg. 1)) then
cai = 0.0
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2000

ik WhNHFHFOOJIOUT B WN R

end if
ctotal (i) = cai

## Solute & H20 drained:
if (i.eq.ncomp) then

# Total H20 drainage (cm) from bottom of soil column:
totdrain = totdrain + h2oout (ncomp)

# Total solute drained (ug/cm”™2) from bottom of soil column:
totsolout = totsolout + cout (ncomp) * h2cout (ncomp)
else

# H20 drained from one compartment and entering next:
h20in(i+l1l) = h2oout (i)

# Solute drained from one compartment and entering next:
cin(i+l) = cout (i)
end if

## Stored H20 in soil column:
storeh20 = storeh2o + sh2o0(i)

## Partitioning of solute (cai) into ads & sol'n phases after irrig:
call adsorption(err)
if (err .ne. 0) return

## Solute in soil column:

# Total solute in solution (ug/cm”3)
totseoln = totsoln + csw(i)*sh2o0 (i)

# Total solute adsorbed (ug/cm”3)
totad = totad + cad(i) * rho(i) * zz (i)
# Total stored solute (ug/cm”3)
totsolst = totsolst + ctotal (i)

continue
return
end

***x** Root Water Uptake Subroutine -- Evapotranspiration
subroutine evapotran(err)

common irrdate, irramt, et, ciw, ph, sph, zz, fc¢, h2omin, k, q,
rho, shZ2o, csw, cad, ctotal, khb, kb, koh, gph, kf, nf,
pdate, mdate, hdate, alpha, rpmax, gamma, watup,
total, h2oin, h2oo0ut, cin, cout, starth2o, startsol,
excess, watcon, solcon, rp, uptake, cbi, aa, beta, a,
temp, zl1l, z2, reluptake, h, oh, b, hb, kchb, kcb,
kcoh, kecg, rootl, root2, root3, mgl, mg2, mg3, phi,
collen, initsol, inith2o0, totet, totdrain, toth2oin,
tothZoout, 1f, storeh2o, totsolin, totsolout, totsolst,
totad, totsoln, avefc, avesat, fcpv, satpv, errh2o,
errsol, jjj, Jjjj, out, printin, nirr,
site, treat, ncomp, ncrop, irr, crop, i, j, unitno,
prnt, diskno, loop, chemmdl, phflg, soil,
kacflg, rootflg, border, fileinput, filename, ht,
printout, jread, mbflg, htitle

implicit real*8 (a-h)
implicit real*8 (p-z)
implicit integer*4 (i-o)



4/2/90 9:26 AM BigBiancal50:TETrans:TETrans-Mac:Tetransl sub.f Page 10

real*8 irrdate(100), irramt(100), et (100), ciw(100), phi (50},
ph(25,100), sph(25), zz(25), fc(25), h2omin(25), k(25),
q(25), rho(25), sh20(25), csw(25), cad(25), ctotal (25),
khb (25), kb(25), koh(25), gph(25), kf(25), nf(25),
pdate (25), mdate(25), hdate(25), alpha(25), rpmax(25),
gamma (25), watup(25), total (25), h2o0in(25),
hZoo0ut (25), cin(25), cout(25), starth2o0(25), startsol (25),
excess, watcon, solcon, rp, uptake, cbi, aa, beta, a, temp,
zl, z2, reluptake, h, oh, b, hb, kchb, kcb, kcoh,
kecg, rootl, root2, root3, mgl, mg2, mg3, collen, initsol,
inith2o0, totet, totdrain, toth2oin, toth2oout, 1f,
storeh2o, totsolin, totsolout, totsolst, totad, totsoln,
avefc, avesat, fcpv, satpv, errh2oc, errsol

WNhHFHwoJIovd W

integer*4 err

integer*4 333, jjjj, out, printin, nirr, site,

1 treat, ncomp, ncrop, irr, crop, i, Jj, unitno, prnt,
2 diskno, loop, chemmdl, phflg, soil, kacflg,

3 rootflg(25), printout, Jjread, mbflg

character htitle*77, border*56, fileinput*20, filename*20, ht

C Initialize:

mat watup = 0.0

C Compute total ET (for mass balance):

totet = totet + et (irr)

G Calculation of exponential plant water uptake parameters:

if ( rootflg(crop) .eq. 2 ) then
if ( rp .eq. 0.0 ) then

excess = et (irr)
else
excess = 0.0

a = alpha(crop)/rp
temp = 1.0 - dexp(-a*rp)
end if
end if

C Calculation of Perrochet/Ritchie linear plant water uptake model coefs:

if ( rootflg(crop) .eqg. 3 ) then
if ( rp .eq. 0.0 ) then

excess = et (irr)
rootl = 0.0
root2 = 0.0
root3 = 0.0
else
excess = 0.0
rootl alpha (crop) / (rp**2)

o

root?2 alpha(crop)/rp
root3 = 1.0/rp
end if
end if
G Compute water uptake from each increment, where zl is the top and
e zZ2 is the bottom depth of the increment:
z1 = 0.0
do 3000 i=1, ncomp
z2 = z1 + zz (i)

G Exponential plant water uptake model
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if ( rootflg(crop) .eq. 2 ) then
if ( rp .le. z1l ) then
uptake = 0.0
else if ( rp .gt. z1 .and. rp .lt. z2 } then
reluptake = (dexp(-a*zl) - dexp(-a*rp))/temp
uptake = reluptake*et (irr)
else
reluptake = (dexp(-a*zl) - dexp(-a*z2))/temp
uptake = reluptake*et (irr)
end if
end if

c Perrochet/Ritchie plant water uptake model
if ( rootflg(crop) .eq.3 ) then
if ( rp .le. z1l) then
uptake = 0.0
else if ( rp .gt. zl1 .and. rp .1lt. z2 ) then

reluptake = rootl* ((rp**2) - (zl**2))
& - (root2 - root3)*(rp - zl)
uptake = reluptake*et (irr)
else
reluptake = rootl* ((z2**2) - (zl**2))
& - (root2 - root3)*(z2 - =zl1)
uptake = reluptake*et (irr)
end if
end if
C Remove ET from soill water profile
sh2o0 (i) = sh2o0(i) - uptake - excess
watup (i) = uptake + excess .
if ( sh2o0(i) .ge. h2omin(i) ) then
excess = 0.0
else
if (i .eqg. ncomp ) then
err = 2
return
else
watup(i) = fc(i) - hZomin (i)
excess = h2omin(i) - sh2o(i)
sh20(i) = hZomin (i)
end if
end if
zl = =z2
C Partitioning of solute into adsorbed & solution phases after ET

call adsorption(err)
if ( err .ne. 0 ) return
3000 continue
return
end

& ***** Adsorption Subroutine
subroutine adsorption(err)

common irrdate, irramt, et, ciw, ph, sph, zz, fc, hZomin, k, g,
rho, sh2o, csw, cad, ctotal, khb, kb, koh, gph, kf, nf,
pdate, mdate, hdate, alpha, rpmax, gamma, watup,
total, h2o0in, h2cout, cin, cout, starth2o, startsol,
excess, watcon, solcon, rp, uptake, cbi, aa, beta, a,
temp, z1, z2, reluptake, h, oh, b, hb, kchb, kcb,
kcoh, kcqg, rootl, root2, root3, mgl, mg2, mg3, phi,

U W
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errsol, j3jj, jjijj, out, printin, nirr,

prnt, diskno, loop, chemmdl, phflg, soil,
kacflg, rootflg, border, fileinput, filename, ht,
printout, jread, mbflg, htitle

s WP Wwoo 4

implicit real*8 (a-h)
implicit real*8 (p-z)
implicit integer*4 (i-o0)

collen, initsol, inith2o0, totet, totdrain, toth2oin,
toth2oout, 1f, storeh2o, totsolin, totsolout, totsolst,
totad, totsoln, avefc, avesat, fcpv, satpv, errh2o,

site, treat, ncomp, ncrop, irr, crop, i, j, unitno,

real*8 irrdate(100), irramt(100), et (100), ciw(100), phi(50),

khb(25), kb(25), koh(25), gph(25), kf(25), nf(25),
gamma (25), watup(25), total(25), h2o0in(25),

excess, watcon, solcon, rp, uptake, cbi, aa, beta,
zl, z2, reluptake, h, oh, b, hb, kchb, kcb, kcoh,

inith2o0, totet, totdrain, toth2o0in, tothZoout, 1f,

WNHWYLRJIOU s W

avefc, avesat, fcpv, satpv, errhZo, errsol
integer*4 err

integer*4 3j3jj, jijij, out, printin, nirr, site,
treat, ncomp, ncrop, irr, crop, i, j, unitno, prnt,
diskno, loop, chemmdl, phflg, soil, kacflg,
rootflg(25), printout, jread, mbflg

w M-

character htitle*77, border*56, fileinput*20, filename*20,

C ## No adsorption

if (chemmdl.eqg.l) then
if (sh20(i).eqg.0.0) then

err = 4
return
else
csw(i) = ctotal(i) / sh2o(i)
cad(i) = 0.0
end if
C ## Langmuir adsorption model routine

else if (chemmdl.eqg.2) then
if ((k(i).eq.0.0).o0or.(g(i).eq.0.0)) then
if (sh20(i).eq.0.0) then

err = 4
return
else
csw((i) = ctotal(i) / shZ2o(i)
cad(i) = 0.0
end if

else
if (sh20(i).eq.0.0) then
csw(i) = 0.0
cad(i) = ctotal(i) / (rho(i)*zz (1))
else if (ctotal(i).eq.0.0) then
csw(i) = 0.0
cad (i) 0.0

If

else

ph(25,100), sph(25), zz(25), fc(25), hZomin(25), k(25),
q(25), rho(25), sh2o0(25), csw(25), cad(25), ctotal(25),

pdate (25), mdate(25), hdate(25), alpha(25), rpmax(25),

h2oout (25), cin(25), cout(25), starth20(25), startsol(25),
a, temp,

kcqg, rootl, root2, root3, mgl, mg2, mg3, collen, initsol,

storeh?o0, totsolin, totsoclout, totsolst, totad, totsoln,

ht

12
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aa = sh2o(i)+zz (i)*rho(i)*k(i)*qg(i)-ctotal (i) *k (1)
csw(i) = (-1l.0*aa+dsgrt(aa**2.0+(4.0*sh2o0(i)*k(i)*

1 ctotal(i)))) / (2.0*sh2o0(i)*k(i))
cad(i) = (ctotal(i)-(sh2o(i)*csw(i))) / (rho(i)*
1 zz (1))
end if
end if

C ## Keéren boron adsorption model routine
else if (chemmdl.eq.3) then
if ((gph(i).eq.0.0).or. ((khb(i).eq.0.0).and. (kb(i).
1 eq.0.0))) then
if (sh20(i).eq.0.0) then
err = 4
return
else
csw(i) = ctotal(i) / sh2o(i)
cad(i) = 0.0
end if
else
if (sh2o0(i).eq.0.0) then
csw(i) = 0.0
cad(i) = ctotal(i) / (rho(i)*zz (i))
else if (ctotal(i).eq.0.0) then
csw(i) = 0.0
cad(i) = 0.0
else
alphal = (10.0**9.15) / (10.0**ph(i,irr))
betal = (koh(i)*(10.0**ph(i,irr)))/(10.0**14.0)
al = 10811.0 *sh2o(i)*(alphal+l1.0)*(((1.0/
1 mgl) *khb (i) *glphal)+((1.0/mg2)*kb(i)))
bl = (10811.0*sh2o0(i)* (alphal+l.0)* ((1.0/mg3)
1 *betal+l1.0)) + (rho(i) *zz(i)*gph(i)-
2 ctotal (i))*(((1.0/mgl)*khb(i)*alphal)+
3 ((1.0/mg2)*kb(i)))
cl = —ctotal(i)*((1.0/mg3)*betal+l.0)
dl = ((dabs(bl))**2.0) - (4.0*%al*cl)
b = (-bl + dsgrt(dl)) / (2.0*al)
hb = b * alphal
csw(i) = 10811.0 * (b + hb)
cad(i) = (ctotal(i)-(csw(i)*shZ2o(i))) / (rho(i)=*
1 zz (1))
end if
end if
04

## Freundlich/linear adsorption model
else if (chemmdl.eq.4) then
if (kf(i).eq.0.0) then
if (sh20(i).eq.0.0) then

err = 4
return
else
csw(i) = ctotal(i) / sh2o(i)
cad(i) = 0.0
end if

else if (nf(i).eq.1.0) then
if (sh2o0(i).eq.0.0) then

csw(i) = 0.0
cad(i) = ctotal (i) / (rho(i)*zz(i))
else
csw(i) = ctotal(i) / (sh2o(i) + zz(i)*rho(i)*
kf(i))
cad (i) = (ctotal(i)-(csw(i)*sh2o(i))) / (rho(i)*
zz {1))

end if

Page 13
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else
if (sh2o0(i).eq.0.0) then
csw(i) = 0.0
cad(i) = ctotal(i) / (rho(i)*zz(i))
else if (ctotal(i).eq.0.0) then
csw(i) = 0.0
cad(i) = 0.0
else
call modnewt (err)
if ( err .ne. 0 ) return
cad(i) = (ctotal(i)-(csw(i)*sh2o0(i))) / (rho(i)*
zz (1))
end if
end if
end if

## Additional error checks

if ((csw(i).1t.0.0).or.(cad(i).1t.0.0).0or. (ctotal(i).1t.0.0)) then
err = 10
return

end if

return
end

***x*xx Modified Newton-Raphson Method Subroutine
subroutine modnewt (err)

common irrdate, irramt, et, ciw, ph, sph, zz, fc, hZ2omin, k, g,
rho, sh2o0, c¢sw, cad, ctotal, khb, kb, koch, gph, kf, nf,
pdate, mdate, hdate, alpha, rpmax, gamma, watup,
total, h2o0in, h2cocut, cin, cocut, starth2c¢, startsol,
excess, watcon, solcon, rp, uptake, cbi, aa, beta, a,
temp, zl, z2, reluptake, h, oh, b, hb, kchb, kcb,
kcoh, kcqg, rootl, root2, root3, mgl, mg2, mg3, phi,
collen, initsol, inith2o, totet, totdrain, toth2oin,
toth2oo0ut, 1f, storehZo, totsolin, totsolout, totselst,
totad, totsoln, avefc, avesat, fcpv, satpv, errhZo,
errsol, j3j3j, 3jjj, out, printin, nirr,
site, treat, ncomp, ncrop, irr, crop, i, Jj, unitno,
prnt, diskno, loop, chemmdl, phflg, soil,
kacflg, rootflg, border, fileinput, filename, ht,
printout, jread, mbflg, htitle

implicit real*8 (a-h)
implicit real*8 (p-z)
implicit integer*4 (i-o)

real*8 irrdate(100), irramt(100), et (100), ciw(100), phi(50),
ph(25,100), sph(25), zz(25), fc(25), hZomin(25), k(25),
g(25), rho(25), sh20(25), csw(25), cad(25), ctotal (25},
khb(25), kb(25), koh(25), gph(25), kf(25), nf(25),
pdate (25), mdate(25), hdate(25), alpha(25), rpmax(25),
gamma (25), watup(25), total(25), h2o0in(25),
h2o00ut (25), cin(25), cout(25), starth2c(25), startsol(25),
excess, watcon, solcon, rp, uptake, chi, aa, beta, a, temp,
zl, z2, reluptake, h, oh, b, hb, kchb, kcb, kcoh,
kcqg, rootl, root2, root3, mgl, mg2, mg3, collen, initsol,
inith2o0, totet, totdrain, toth2o0in, tothZoout, 1f,
storeh2o0, totsolin, totsolout, totsolst, totad, totsoln,
avefc, avesat, fcpv, satpv, errhZo, errsol

14
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integer*4 err

integer*4 3jjj, 3jjjj, out, printin, nirr, site,

1 treat, ncomp, ncrop, irr, crop, i, Jj, unitno, prnt,
2 diskno, loop, chemmdl, phflg, soil, kacflg,

3 rootflg(25), printout, jread, mbflg

character htitle*77, border*56, fileinput*20, filename*Z20, ht,

## Determines the root (i.e., csw) of the Freundlich based
function f(x)=0 using the modified Newton-Raphson method
combined with the bisection method to prevent the root
from being a negative number

phi = difference between current iteration's zero
value and the previous iteration's value
terror = allowable error set within source code

xinit = initial value of root (csw)
x = current value of root (csw)}
fx = function f(x)

fpx = £'(x)
fdpx = £'" (%)
ux = u(x) = £(x) / £'(x)

upx = u'(x) = 1.0 - £(x) * £''(x) / £'(x)**2

## Set tolerance error
terror = 0.00000001

## Set inital guess for x
xinit = ctotal(i) / (sh2o0(i) + zz(i)*rho(i)*kf(i))
X = xinit

## Determine coefs. for f(x)

al = rho(i) * zz (i) * k£f(i)
bl = sh2o0(i)

cl = ctotal (i)

## Solve for csw

K] =L

J7)] = @

phi(jjj) = 1.0

## Modified Newton-Raphson method with the bisection method used
whenever Newton-Raphson would take the solution below zero
do while ((dabs(phi(jjj)).gt.terror).and. (jjj.le.50))
333 = 333 + 1
fx = (al*(x**nf(i))) + bl*x - cl
fpx = (al*nf(i)*(x**(nf(i)-1.0))) + bl
fdpx = al*nf (i)*(nf{i)-1.0)*(x**(nf(i)-2.0))
ux = fx / fpx
upx = 1.0 - ((fx * fdpx) / (fpx**2.0))
phi (§33) = -ux / upx
x1l = x + phi(j33)
# Bisection routine
if ((x1.1t.0.0).and. (dabs(phi(jjj)).gt.terror)) then
do while (x1.1t.0.0)
x1l = (x14+4x) / 2.0
end do
end if
# Reset approximation to new approximation
x = x1

Page
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# Check for divergence

if ((dabs(phi(3jjj)).gt.dabs(phi(jjj-1)))) then
J Ikl = Ha99 4 1
if (jjjj.ge.10) then

err = 5
return
end if
“end if
end do

## Check for a negative root (Note: concentrations cannot be

negative.)
if (x.1t.0.0) then
err = 6
return
end if

## Check for lack of convergence
if (jjj.ge.50) then

err = 3
return
end if
## Set equilibrium solution conc. equal to x
csw({i) = x
return
end

***** Read Input File Subroutine
subroutine inroutine(err)

common irrdate, irramt, et, ciw, ph, sph, zz, fc, h2omin, k, q,
rho, sh2o, csw, cad, ctotal, khb, kb, koh, gph, k£f, nf,
pdate, mdate, hdate, alpha, rpmax, gamma, watup,
total, hZo0in, h2o0o0ut, cin, cout, starth2o, startsol,
excess, watcon, solcon, rp, uptake, cbi, aa, beta, a,
temp, zl, z2, reluptake, h, oh, b, hb, kchb, kcb,
kcoh, kecqg, rootl, root2, root3, mgl, mg2, mg3, phi,
collen, initsol, inithZ2o, totet, totdrain, tothZoin,
toth2ccut, 1f, storeh2o, totsolin, totsolout, totsolst,
totad, totsocln, avefc, avesat, fcpv, satpv, errhZo,
errsol, 3jjj, 3jjjj, out, printin, nirr,
site, treat, ncomp, ncrop, irr, crop, i, 3j, unitno,
prnt, diskno, loop, chemmdl, phflg, soil,
kacflg, rootflg, border, fileinput, filename, ht,
printout, jread, mbflg, htitle

implicit real*8 (a-h)
implicit real*8 (p-z)
implicit integer*4 (i-o)

real*8 irrdate(100), irramt(100), et(100), ciw(100), phi (50},
ph(25,100), sph(25), zz(25), fc(25), h2omin(25), k (25},
g(25), rho(25), sh20(25), csw(25), cad(25), ctotal(25),
khb(25), kb(25), koh(25), gph(25), kf(25), nf(25),
pdate (25), mdate(25), hdate(25), alpha(25), rpmax (25},
gamma (25) , watup (25}, total(25), h2cin(25),
hZoout (25), cin(25), cout(25), starth2o(25), startsol (25),
excess, watcon, solcon, rp, uptake, cbi, aa, beta, a, temp,
zl, z2, reluptake, h, oh, b, hb, kchb, kcb, kcoh,

Page 16
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kcg, rootl, root2, root3, mgl, mg2, mg3, collen, initsol,
inith20, totet, totdrain, toth2cin, tothZoout, 1f,
storeh2o0, totsolin, totsolout, totsolst, totad, totsoln,
avefc, avesat, fcpv, satpv, errh2o, errsol

whHwWw

integer*4 err

integer*4 jjj, jjjj, out, printin, nirr, site,

1 treat, ncomp, ncrop, irr, crop, i, j, unitno, prnt,
2 diskno, loop, chemmdl, phflg, soil, kacflg,

3 rootflg(25), printout, jread, mbflg

character htitle*77, border*56, fileinput*20, filename*20, ht
open (diskno, file='TETRANS1.IN', status='old’, readonly)

(8 Read the number of irrigation/precipitation events:
read (diskno,*) nirr

Read the irrigation/ppt. time (in days from time 0), amount of
irrigation/ppt. water (cm), evapotranspiration (cm) and
irrigation/ppt. water solute concentration (mg/l):
do 9050 i=1,nirr
read (diskno,*) irrdate (i), irramt(i), et(i), ciw(i)
9050 continue

QaO

C Read the number of increments comprising the soil profile:
read (diskno,*) ncomp

c Read the pHs for each soil increment, by event:
do 9120 i=1,nirr
do 9110 j=1,ncomp
read (diskno,*) ph(j,1i)
9110 continue
9120 continue

& Read in the type of chemical model:
read (diskno, *) chemmdl

For each increment read the increment thickness (cm), field-capacity
water content (cm/cm), minimum water content allowed (cm/cm),

Langmuir affinity constant (1/mg), Langmuir adsorption maximum (mg/kg),
Keren KHB (ml/mg), Keren KB (ml/mg), Keren KOH (ml/mg), Keren adsorption
maximum (mg/kg), Freundlich K (ppm) & n (dimensionless), scil bulk
density (g/cm”3), initial soil water content (cm/cm), initial soil water
solute conc. (mg/l), initial soil pH and piston-mixing factor:

do 9175 i=1,ncomp

read (diskno,*) zz(i),fc(i),hZomin(i),k(i),qg(i),khb(i),kb(i),koh(i),

PN NN RO NP NP]

& gph(i),kf(i),nf (i), rho(i),sh20(i),csw(i),sph(l),gamma (i

9175 continue

C Read the number of crops:
read (diskno,*) ncrop

For each crop, read the planting, maturing and harvesting times (in days
from time 0), the maximum plant root penetration (cm), the root uptake
model (2 = exponential uptake, 3 = linear uptake) and the mature plant's
root uptake profile coefficient for that model:

do 9290, i=1,ncrop

read (diskno,*) pdate (i), mdate(i),hdate (i), rpmax (i), roctflg(i),alpha (i)
9290 continue

NN Ne]

close (diskno)

17
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return
end

C**** Write the raw after irrigation data to the output file:

C'k‘k‘k*

10

Cx *x*%x

ChH*xx

subroutine savedatl ()

common irrdate, irramt, et, c¢iw, ph, sph, zz, fc, hZomin, k, g,
rho, sh2o0, c¢sw, cad, ctotal, khb, kb, koh, gph, kf, nf,
pdate, mdate, hdate, alpha, rpmax, gamma, watup,
total, h20in, h2oout, c¢in, cout, starthZ2o, startsol,
excess, watcon, solcon, rp, uptake, cbhi, aa, beta, a,
temp, zl, z2, reluptake, h, oh, b, hb, kchb, kcb,
kcoh, kcg, rootl, root2, root3, mgl, mg2, mg3, phi,
collen, initsol, inith2o0, totet, totdrain, toth2o0in,
toth2o0ut, 1f, storeh2o, totsolin, totsolout, totsolst,
totad, totsoln, avefc, avesat, fcpv, satpv, errhZo,
errsol, 3jjj, 3jjjij, out, printin, nirr,
site, treat, ncomp, ncrop, irr, crop, i, 3j, unitno,
prnt, diskno, loop, chemmdl, phflg, soil,
kacflg, rootflg, border, fileinput, filename, ht,
printout, Jjread, mbflg, htitle

ik WNRFRFWOVWOJIJOUTE WNE

implicit real*8 (a-h)
implicit real*8 (p-z)
implicit integer*4 (i-o)

real*8 irrdate(100), irramt(100), et (100), ciw(100), phi(50),
ph(25,100), sph(25), zz(25), fc(25), h2omin(25), k(25),
g(25}),; Tho(25),; sh20(25); €sw(25), vad(25); ctotali(2b);
khb(25), kb(25), koh(25), gph(25), kf(25), nf(25),
pdate (25), mdate(25), hdate(25), alpha(25), rpmax(25),
gamma (25), watup(25), total (25), h2o0in(25),
hi2eont (25), cin(25), cout (25),; starth26(25h), startsel (25);
excess, watcon, solcon, rp, uptake, cbi, aa, beta, a, temp,
zl, z2, reluptake, h, oh, b, hb, kchb, kcb, kcoh,
kcq, rootl, root2, root3, mgl, mg2, mg3, collen, initsel,
inith2c, totet, totdrain, toth2o0in, toth2oo0ut, 1f,
storeh2o0, totsolin, totsolout, totsolst, totad, totscln,
avefc, avesat, fcpv, satpv, errh2o, errsol

WNhHFOXJdJo U WK

integer*4 3jjj, jjjj, out, printin, nirr, site,
treat; ncompy nNerop; 1i¥ry cerop; 1; 7, unitno; prnt,
diskno, loop, chemmdl, phflg, soil, kacflg,
rootflg, printout, Jjread, mbflg

W N -

character htitle*77, border*56, fileinput*20, filename=*20, ht

Write simulation data to file:
write (99, ' (f15.7)') rp
do 10 1 = 1, ncomp
write (99, ' (3f15.7)') csw(i), cad(i), ctotal(i)/zz (i)
continue

Write leaching fraction and pore volume data to file:
write (99, '(2f15.7)') 1f, satpv

Write mass balance data to file:

write (99, '(6f15.7)') toth2oin, totet, totdrain, toth2oout, storeh20,errh2o
write (99, '(6£15.7)') totsolin,totsolout,totsoln,totad,totsolst,errsol
return

end

18



4/2/90 9:26 AM BigBiancal50:TETrans:TETrans-Mac:Tetransl sub.f

Cr*** Write the raw after et data to the output file:

subroutine savedat2()

common irrdate, irramt, et,
rho, sh2o0, csw, cad,
pdate, mdate, hdate,
total, h2o0in, h2o0o0ut, cin,
excess, watcon, solcon, rp,
temp, zl, z2, reluptake, h,
kcoh, kcqg, rootl, root2, root3, mgl,
collen, initsol, inithZ2o,
toth2o0ut, 1f, storeh2o, totsolin,
totad, totsoln, avefc, avesat, fcpv,
errsol, 3jjj, 3J3jjj, out, printin,
site, treat, ncomp, ncrop, irr,
prnt, diskno, loop, chemmdl, phflg,
kacflg, rootflg, border, fileinput,
printout, jread, mbflg, htitle

sph, zz,
khb,
rpmax,
cout,
uptake,

ciw, ph,
ctotal,
alpha,

HiEE;

NibWNHOC-I WU B WN

implicit real*8 (a-h)
implicit real*8 (p-z)
implicit integer*4 (i-o)

real*8 irrdate(100), irramt (100), et (100),
ph(25,100), sph(25), zz(25), fc(25),
g(25), rho(25), sh2c(25), csw(25),
khb (25), kb(25), koh(25), gph(25),
pdate (25), mdate (25), hdate(25),
gamma (25), watup(25), total (25),
hZ2o0ut (25), c¢in(25), cout(25),
excess, watcon, solcon, rp, uptake,
zl, z2, reluptake, h,
kcg, rootl, root2,
inith2o0, totet, totdrain,
storeh20, totsolin,
avefc, avesat, fcpv,

toth2oin,

WNhHRHOUDDJIULT WP

satpv, errhZzo,

integer*4 jjj, jjjj, out, printin, nirr,
treat, ncomp, ncrop, irr, crop, i, 7,
diskno, loop, chemmdl, phflg, soil,
rootflg, printout, jread, mbflg

(VIO

fc, h2omin,
kb, koh, gph, kf, nf,
gamma,
starthZo,
cbi,
oh, b, hb, kchb, kcb,

mg2, mg3, phi,
totet, totdrain,
totsolout,
satpv,

CLOpR, i,
soil,
filename, ht,
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k, q,

watup,
startsol,
aa, beta, a,

tothZoin,
totsolst,
errhZo,

j, unitno,

ciw(100), phi(50),
h2omin(25),
cad(25),
kf(25),
alpha(25),
h20in (25),
starth2o0(25),
cbi,
oh, b, hb, kchb, kcb, kcoh,
root3, mgl, mg2, mg3,

k(25),
ctotal (25),

nf (25),
rpmax (25),

startsol (25),
aa, beta, a, temp,

collen, initsol,

toth2o00ut, 1f,
totsolout, totsolst,

totad, totsoln,

errsol

site,
unitno, prnt,
kacftlg,

character htitle*77, border*56, fileinput*20, filename*20, ht

C**** Write data to file:
do 10 i=1,ncomp

if ( et(irr) .eq. 0.0 ) then
hZoup = 0.0
else
hZ2oup = (watup(i)/et (irr))*100.0
end if
write (99, '(4f15.7)') h2oup, sh2o(i)/zz (i),
10 continue
return
end
C Error Message Subroutine

function errmess(err, irrnum)

csw(i), cad(i)
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integer*4 err
integer*4 irrnum
string*200 mess
character*200 msg

if (?rr.eq.l) then

else

else

write(msg,'(a,i3)') 'MODEL
mess = msg

call ErrorDlog(mess)
return

if (err.eq.2) then
write (msqg, ' (a,i3)"') 'MODEL
mess = msg

call ErrorDlog(mess)
return

if (err.eq.3) then

write (msg, ' (a,13)"') '"ERROR:

mess = msg
call ErrorDlog(mess)

return

else if (err.eq.4) then
write(msg,'(a,i3)') "MODEL
mess = msg
call ErrorDlog(mess)
return

else i1f (err.eq.5) then
write(msg, ' (a,i3)') "MODEL
mess = msg
call ErrorDlog(mess)
return

else if (err.eq.6) then
write(msqg, ' (a,i3)"') "MODEL
mess = msg
call ErrorDlog(mess)
return

else if (err.eq.10) then
write(msg,'(a,1i3)') 'MODEL
mess = msg
call ErrorDlog(mess)
return

end if

return

end

ERROR:

ERROR:

Lack

ERROR:

ERROR:

ERROR:

ERROR:

CHh*x*Fxhhhkhkkhkhhohhhrdxkk Routines which access

C CheckAbort

C Check for command-.

subroutine CheckaAbort (err)

''SETC USINGINCLUDES = FALSE
include 'events.f!

record /EventRecord/ the event

Irrigation event has insufficient wa

Insufficient water in column to meet

of convergence in Newton-Raphson meth

Improbable scenario - No adsorption

Divergence in Newton-Raphson method.

Newton—-Raphson approximation less th

Adsorbed, solution or total concentr

the Mac toolbox follow ***FF*Fxxxxd&x&x%

or command-q key press in event queue.
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integer*4 err

leogical*l an_event

integer*2 chcode, event mask
character*l ch

event

_mask = $0008 ! Check for key-down event only

an_event = getnextevent(%val(event_mask),%ref(theﬁevent))
if (an_event) then

if

{the_event.what = 3) then ! key press
chcode = Jiand(the_event.message, charCodeMask)
ch = char (chcode)

chcode = jiand(the_event.modifiers, cmdKey)

if ((chcode .NE. 0).and.((ch = ".').or.(ch = 'Q").or. (ch =

end if

end 1
retur
end

! Error
! Post

subro
strin

bl
n

Dlog
an error alert

utine ErrorDlog(str0)
g*200 str0,strl,str2,str3

integer*2 alertID
integer*4 nil,ret

nil =
alert
strl
sEr2
str3
call
call
ret =
retur
end

0
ID = 5000
N
= 1 1
— 1
InitCursor

ParamText (%val (stx0), %val (strl), %val (str2),%val (str3))
StopAlert ($vVal (alertID), %Val(nil))
n
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'gq'))) err



